Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver.4.15
Instruction Manual

Content of this Instruction Manual
DPP stands for Digital Photo Professional.

» indicates the selection procedure of the menu.

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.

Click to move to the relevant page.

indicates the function for advanced

users who are experienced in handling image

processing software.

"2 : Marks helpful information when a problem
arises.

-
~

N1/
s

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

&l

Switching Between Pages
Click on arrows on the bottom right of the screen.

(O : next page

() : previous page

@) : return to a page you had previously
displayed
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction Downloading
Images
e
- Color management compatibility =
Mal n Featu res Of D P P CMYK simulation for commercial printing era‘:ggg
Following are the main tasks you can perform with images you have
downloaded to your computer. _
* indicates processing that can be performed with JPEG or Sorting
; . Images
TIFF images as well as RAW images.
View and organize images EdTTing
Play back movies and save still photos Images
Adjust an image -
Various image adjustments while maintaining the original image ';22323
S
F.reely app'ly a Picture Style . . ' Processing
View your image before and after adjustment in the same window Large Numbers
of RAW Images
Trim and adjust the angle of an image -
(trimming) Shooting
Resize an image 1 Flaing Back
. . i d Savi
Correction of lens aberration *Stil Photos
Digital Lens Optimizer _
. . Handling
Automatic/manual dust erasure processing RAW Movies
. HDR PQ
Convert from a RAW image to a JPEG or Mode
TIFF image and save
Process Iarg(_e number§ of RAW_ |.mages in batches @ In DPP Ver. 4.8.20 or later, clicking [Check for updates] in the g‘g?:rig‘iggs
Transfer the image to image editing software [Digital Photo Professional 4] menu allows you to check for update
Print an image files on the server and download any update files that are available.
] ] . . To use this function, an environment with Internet access @ @
Link with EOS Utl|lty for remote shootlng (subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply. @
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System Requirements

OS (operating
system) macOS 10.14 to 10.15, 11
Model PC with one of the above OS preinstalled
(Upgraded machines not supported)
Images shot with EOS-1D X Mark Ill, EOS R5,
EOS R6:
Intel Core i series (recommended Intel Core i7 or
CPU later), Apple M1*
Images shot with other cameras:
Core 2 Duo 2.0 GHz or faster (recommended Core i
series or later), Apple M1*
Images shot with EOS-1D X Mark Ill, EOS R5, EOS
R6:
RAM 4.0 GB or more of RAM (8.0 GB or more
(memory) recommended)
y Images shot with other cameras:
2.0 GB or more of RAM (4.0 GB or more
recommended)
Hard disk Installation: Min. 300 MB of available space
drive Operation: Min. 600 MB of available space
Resolution: XGA (1024 x 768) or more (1600 x 1200
Display or more recommended)
Colors: 16-bit color (65536 colors) or more

* On an Apple M1

computer, runs with Rosetta 2 installed.

|§| For information on system requirements for HDR PQ mode
(including supported images), see “System Requirements for
HDR PQ Mode” (p.165).
For details on system requirements for the RAW movie tool, see
“Working with RAW Movies” (p.154).
For images supported by depth compositing, see “Using Depth
Compositing” » “Supported Images” (p.117).

Supported Cameras

EOS-1D X Mark lll, EOS-1D X Mark Il, EOS-1D X, EOS-1D C, EOS-1D Mark IV,

EOS-1Ds Mark lll, EOS-1D Mark lll, EOS-1D Mark II N, EOS-1Ds Mark I, EOS

1D Mark I, EOS-1D, EOS-1Ds, EOS 5DS/EOS 5DS R, EOS 5D Mark IV, EOS

5D Mark lll, EOS 5D Mark II, EOS 5D, EOS 6D Mark Il, EOS 6D, EOS 7D Mark

I, EOS 7D, EOS 90D, EOS 80D, EOS 70D, EOS 60D/EOS 60Da, EOS 50D,

EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS

D6000, EOS D30, EOS D60, EOS 77D, EOS REBEL T6S/760D, EOS REBEL

T8i/850D, EOS REBEL T7i/800D, EOS REBEL T6i/750D, EOS REBEL T5i/

700D, EOS REBEL SL3/250D/200D I, EOS REBEL SL2/200D, EOS REBEL

SL1/100D, EOS REBEL T7/2000D/1500D, EOS REBEL T6/1300D, EOS

REBEL T5/1200D, EOS REBEL T4i/650D, EOS REBEL T3i/600D, EOS

REBEL T2i/550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D,

EOS DIGITAL REBEL XS/1000D, EOS REBEL T3/1100D, EOS DIGITAL

REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, EOS

REBEL T100/4000D/3000D, EOS DIGITAL REBEL/300D, EOS R5, EOS RS,

EOS R, EOS Ra, EOS RP, EOS M6 Mark Il, EOS M6, EOS M5, EOS M3, EOS

M2, EOS M, EOS M10, EOS M200, EOS M100, EOS M50 Mark Il, EOS M50,

PowerShot G3 X', PowerShot G1 X Mark I, PowerShot G7 X !, PowerShot

G9 X, PowerShot SX60 HS ', PowerShot G5 X !, PowerShot G7 X Mark I,

PowerShot G16 ', PowerShot $120', PowerShot G1 X !, PowerShot G15

PowerShot S110 ', PowerShot S100 ', PowerShot G9 X Mark II'", PowerShot

G1 X Mark III"", PowerShot G9 "2, PowerShot G10 "2, PowerShot G112,

PowerShot G122, PowerShot S90 "2, PowerShot S95 ', PowerShot SX1

IS"2, PowerShot SX50 HS ™2, PowerShot SX70 HS 12, PowerShot G5 X

Mark II"", and PowerShot G7 X Mark II””

*1 For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in the
camera, can be used with the exception of some functionality.

*2 The following functions are unavailable.

- Basic Adjustment tool palette:
White balance [Fine-tune]
A portion of [Gamma adjustment]
Automatic gradation and luminance adjustment
Midpoint adjustment
Input white points range expansion
- Dust Delete/Copy Stamp tool palette
- Compositing tool
- HDR tool
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Supported Images

Image data
Image type Extension
.CR3
'RAW | Images in the Canon RAW format '%Ez
images | shot on supported cameras ‘CRW
.CIP
Still . .
TIFF | Exif-compatible TIFF images TIF/.TIFF
images P 9 : :
HEIF | Images shot on supported cameras, HIF/.HEIC
images | or HEIF images developed in DPP : :
.MQV
Movies Movies shot with supported cameras | .MP4
.CRM

* Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.
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* Sections with and in “4 Editing Images”

support not only RAW image editing but also JPEG/TIFF image
editing.
: All the functions explained in the section support

JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.
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Starting Up DPP ...
Downloading Images to Your Computer

Downloading Images Using the Software “EOS Utility”.......
Downloading Images Using Your Card Reader..........
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Starting up DPP

Double-click the Dock icon.

Digital Photo Professional 4

Double-click

DPP starts up and the main window (thumbnail layout) appears.

v

-
-
-
=
=
=

|§| If you drop a DPP-supported image file onto the icon on the Dock,
you can start up DPP and display the folder where the image file is
saved.
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Downloading Images to Your Computer

Download the images saved on the memory card inserted in the
camera.

Downloading Images Using the Software “EOS Utility”

You can download images with “EOS Utility”, communication software
for the camera.

For detailed instructions on downloading images, refer to the “EOS
Utility Instruction Manual” (PDF electronic manual).

Downloading Images Using Your Card Reader

You can also download images to the computer using a third-party card
reader.

Load the memory card into the card reader.
Start up DPP beforehand.

Open a removable disk icon in the folder area and
drag the [DCIM] folder to the [Desktop].

(& Digital Photo F ional 4 File Edit View Tt ils__Preview |
e 0

Remote Shooting

Folder Bookmark

A cos DiGITAL
i pcim

| misc
B Macintosh HD
8 Applications

8 Temporary ltems
8 Users

8 Shared

ﬁ XXX

The [DCIM] folder is copied to your computer.

All images are saved in folder units inside the [DCIM] folder.
Copying images to your computer will take some time when there
is a large number of images saved on the memory card.
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Viewing Images in the Main Window (Thumbnail Layout)

Images downloaded to your computer are displayed as a thumbnails list
in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.18) and display the image at large size.

Main window Toolbar

(o File Gt _View _Thumbnais_Prevew L |si_Adjutment D % = unisim G =
s

Check marks (p.33, p.34)
Ratings (p.33, p.34) Rotate image

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.182).

Forward/Reverse

For information on movie files, see “Playing Back Movies and
Saving Still Photos” (p.150).

When aspect ratio information is attached to an image shot with
any supported camera other than the EOS 5D Mark Il, the image
is displayed as a cropped image (p.71).

In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the
image in detail (p.20).
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Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu » desired item.

Thumbnails
Open preview screen H®O
v Thumbnail control panel EN

Apply display filter
Sort >
Group RAW and JPG versions

+ Display split files as one thumbnail

Hide file name

v Default
With shooting info
List view
Size 1 (84xB84) 81
Size 2 (126x126) 82
Vv Size 3 (168x168) 283
Size 4 (252x252) %84
Size 5 (384x384) 85
Size 6 (512x512) 386
AF points xXJ

The display changes to the selected item.
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Downloading
Images

Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions
(1) (2) () (4) (5) () (7) (8) (9 (10) Editing
Images
Printing
Images
(1) ENmamiel Change the size of thumbnails (8) Display or play back split movie files as single movies
2) uDispIay thumbnails without file names When you play back split movie files in DPP, this setting plays 1 Procﬁssirl;g
. . back all the movie files in a continuous sequence from the ?%:Wlllm ers
(3) EDlspIay standard thumbnails beginning. v it
4) E Display thumbnails with information + This is set to ON by default. Remote
(5) E Display thumbnails in list . On.Iy the.thum.bnail for the first mpvie file is displayed. . Shooting
» This setting will be kept and applied the next time DPP is
(6) H Specify properties display settings (p.177) started up. Sy
= . . . laying Back
(7) Display a RAW image and JPEG image as a single image When the folllc_)wmg _fu?_ftlons are us;a]d,ffchey apF?'yff‘IO _a” the Movies and Saving
Display a RAW image and JPEG image that were shot together remaining split movie files, not just t e irst movie file: Still Photos
. X . L i L [Copy], [Cut], [Delete], [Add to collection], [Rename Tool]
as a single image. When this setting is specified, viewing and . . . . .
editing of images are as follows * When the Filter/Sort function (p.16) is used with thumbnails, Handling
' the function is only applied to the first movie file. RAW Movies
» Image displayed: Only the RAW image is displayed in all ,
windows. 9) ESeIect all thumbnails
- Edited image: The content which has been edited with any of ~ (10) [l Cancel all thumbnail selections HIeIEdZQ
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following The thumbnails control panel is displayed in the main window by 4
functions, the adjustments will be applied to both the RAW default. If it is not displayed, such as when screen settings have ;‘g?gr'g:ggs
image and the JPEG image. been changed, you can display it by selecting [Thumbnail control
Deleting an image (p.39) panel] in the [Thumbnails] menu.
Moving or copying an image (p.39) In multi-layout (vertical thumbnails, p.20), only the thumbnail view @ @
Checkmarking (p.33 to p.34) setting (Default thumbnail display) is possible.
Rating (p.33 to p.34)
Rotating an image (p.13) @



Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Set the [Filter] button on the [Filter/Sort pane] in the

main window to [ON].

Filter ON 1 Sort by: Fila name

Specify settings.
(1) () (3) (4)

Filter ON OFF d' Sortby: File name

Shooting Date/Time ¥  Camera Model Name ¥ Lens

All All
EF100mm f/2.8L Macro 1S USM

EF24- im /4L IS USM
EF24mm f/1.4L 1| USM
EF24mm /2.8 IS USM
EF28mm /2.8 IS USM

Filter menu (2)

Filter menu list menu lists upward or downward

You can drag the bottom edge of the [Filter/Sort pane] to adjust

the display area of the filter menu lists upward or downward.

(1) Thumbnail display filter ON/OFF

By setting to [ON], only thumbnails matching the filtering option set

with (2) the filtering options menu are displayed.

Drag to adjust display area of filter

(2) Filtering options menu

Select a filtering option for the thumbnail display filter.

« After selecting a filtering item in the list box that appears by clicking
[¥] at the right on the filter menu, options appear in the filter menu
list. Select an option.

* You can select multiple options in the filter menu list.

(Hold down the <shift> key and click with the mouse for
consecutive selection. Hold down the <command> key and click
with the mouse to select individually.)

» The filter menus/filter menu lists are prioritized from left to right.
You can specify filtering options from left to right to narrow down
filtering.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a “*” is
temporarily displayed after the option name. [Custom] is displayed if
you sorted thumbnails in a chosen way.

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

(5) Filter lock button
When the filter lock button is clicked, filter settings will be kept and
applied when you switch to a different folder or the next time DPP is
started up. When the filter lock button is not clicked, filter settings
automatically change to [OFF] when you switch to a different folder
or the next time DPP is started up.

|§| In addition to thumbnail display, this function can also be used in
multi-layout.
You can open/close the panel by clicking the [¥] button at the
upper right of the [Filter/Sort pane].

Filter ON i Sortby: File name

Shooting Date/Time v Camera Model Name v Lens

All All kil All
X 2 5 EOS XX 11 N EF100mm f/2.8L Macro IS USM
EOS 19 EF16-35mm #/2.8L Il USM

1 EF17-40mm /4L USM
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Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

Histogram

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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[}
e

Double-click

The preview window appears.
Up to 36 windows can be displayed at the same time for the
preview window.

Preview window '

R R T 3

Click the [@] in the Upper left of the preview window to close the

preview window.

Enlarging and Viewing an Image in the Preview Window

|§| By selecting the [Preview] menu » [AF points] in the preview

window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.95), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.
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Downloading

Images
Enlarging and Viewing a Specific Area Displaying the Navigator Palette
Click the area you want to enlarge. The navigator palette shows the enlargement area of a selected image.

T T

Select the [View] menu » [Navigator palette].
The navigator palette appears.

Mavigator Editing
Images
- . IMG_D001.CR2
Mo S =, EQS XX —_—
w11 HIF " Tv 1/40 Printing
T TFF - Av 5.6
.SET?' 150 3200 Images
34.0mm
The area you clicked is enlarged to 100% (actual pixel size). Laf;?ﬁﬁf,:ggrs
Click again to revert to the full view. When an image is enlarged in the preview or other window, the of RAW Images
To change the display area drag on the image. enlargement display area is indicated in the navigator palette. :
The area to be enlarged can be changed by dragging the Remote
Shooting

enlargement display area on the image.

Playing Back
Navigator Movies and Saving
Still Photos
IMG_0001.CR2
= = EOS XX
- i — Change the . Handling
I T —11 s enlargement display RAW Movies
e | e Gk e area by dragging
HDR PQ
Mode

You can click the [ &} ] button at the bottom right of the main
window to show/hide the [Navigator] palette.

- Specifying
=@ To display an image in an enlargement ratio other than 100% Preferences
Select any enlargement ratio from the [Preview] menu.
|§| While in the preview window, you can select the [Preview] menu »

[Preview control panel] to use various preview functions. For details, @

see “Checking an Image Using the Preview Control Panel” (p.21).



Checking the Image in Detail

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).

The main window (multi-layout) appears.
In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.

Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the
image again to revert to full display.

Mam Wlndow (thumbnall Iayout)

Al prevew _(ibel_idjumiment oo

Multl Iayout (horlzontal thumbnalls)

Vo T e G A io

Fie i

i '.rri~ T Preview
‘ s display area
Thumbnail
display area

Layout change button

Horizontal thumbnails

Vertical thumbnails
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[E]] button and [[i#]] button are selected. When you select a
movie, the displayed content changes. For information on the display
when movies are selected, see “Playing Back Movies and Saving Still
Photos” (p.150).

Changing the Magnification

CHC) A B -

Display the image at actual pixel size (100%).

E

Click the [ [ ] button to display the image at the set
maghnification displayed. If the [[ElE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.
*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

button.

D & = & Mon7sieM

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [[E]] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

x1 200~ © @ [M~-[E-[E~-Ff =B ~

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

Displaying Grid Lines

©@ @ [F~[MA~[RE~ = =~

Click the [[] button beside the [[E]] button, and set
the spacing between grid lines on the menu that
appears.
To set the spacing, enter values (8 to 256, in pixels), or move the
slider.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[E]] button.
The image with grid lines is displayed.

Displaying AF Points

x1 2000~ O @® [H~[F~[~ & B ~

Click the [[]]1 button beside the [[E]] button, and
select the item to display on the image on the menu
that appears.

Select [Show only AF points in focus] or [Show all AF points].

Select an image and click the [[£]] button.

An image with the AF points selected in step 1 is displayed.

@ AF points are not displayed for images whose image size has been
changed and then been converted and saved (p.95), images for
which you selected an effect other than [Shot settings] as correction
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for
distortion correction or chromatic aberration correction.
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Downloading
Images

Displaying Areas Beyond the Set Range with Select an image and click the [EF]] button.
Warning Indicators (Highlight/Shadow On the opened image, if there is an area that exceeds the value \Illeng
Warning) entered in step 1, the highlighted part of that area is displayed in °
You can set up warning indicators for both highlighted and shadowed red and the shadowed part is displayed in blue. If you selected _
parts, which is effective for checking the clipped highlights and shadows different warning colors, the parts are displayed in the specified f’r:;t'gg
and preventing excessive adjustment of an image. Where the area on colors. 2
the image has exceeded the set range, you can display the highlighted
part in red and the shadowed part in blue. Comparing Pre- and Post-Editing Images Eﬁ;ﬂ,‘;ﬂ I
(Single-Image Display) ‘
T Printing
[F~ME~-0E~ 6 =&~ © @ [ M-~ - Images
Click the [[§] button beside the [[F]] button, and Select an image that is being edited and click the o
specify settings on the menu that appears. [[iE] button. of RAW Images
—— ; , , By clicking the button, the display switches between the image
MM
8 Highlight/shadow warning display settings before editing and the current image (being edited). S'ng:’i:,eg
[EI Show shadow warnings
Threshold:(0-64) 32 Playing Back
. Movies and Savin
Warning color L Stil Photos
(¥ Show highlight warnings
: . : - Handling
Threshold:{(192-255) I254 RAW Movies
Warning color |-
—_— HDR PQ
| Close | Mode
Checkmark the [Show highlight warnings] and [Show shadow §P?°ifyi"9
warnings] checkboxes and enter the warning values. bR

You can also select different warning colors from the dialog that

appears when you click the [Warning color] box. @ @
After specifying settings, click the [Close] button and close the

window.

23



Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

200+ O @

GHEREREEE

2 =1

Select an image that is being edited and click the
[[EE]] button.

Fredassional bl _Toeven (2l fdpmimest

- i

o ﬂlﬂ‘i .

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.
The display switches in the following order by clicking the [[ii]]
button.
Arrange vertically (two-screen: left/right) = Arrange horizontally
(two-screen: top/bottom) — Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

Displaying Image Properties

Display the shooting and recipe information for an image in the screen.

You can select items to be displayed.

200+ = @

EATERMOE AN B

Click the [[§] button beside the [[[i]] button.
The [Properties display settings] window appears.

Specify display settings.

Preferences

Use Recommended Settings

Show Av/Tv/ISO on thumbnails
Show icon on thumbnail ta indicate edited recipes:

Show HDR icon on thumbnails

n on previews

Display settings for thumbnails with info

File Size

Owner's name

Shooting mode + Metering mode
Aperture Value + Shutter Speed
IS0 Spead

Expusure Compensalion

White balance

Picture Style

Colur space

Size when opening RAW images

Add >>

<< Remove

Browse... Restore Defaults

B Restore Defaults
Clear All

Shooting Date/Time:
Camara Model Name
Image Size + RAW Type
Lens

Focal Langth

Move Lp Move Down
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Select [Display settings for preview properties] from the
[Properties to display] pulldown menu.

Specify display items with the [Add >>] button and [<< Remove]
button. ltems that can be selected appear in the list box at left,
and actually displayed items appear in the list box at right. You
can also change the display order with the [Move Up] button and
[Move Down] button.

After specifying settings, click the [OK] button.

With the [Preview properties font] option, you can specify the font
used for information displayed in the preview window.

Select an image and click the [[[i]] button.

The image and properties selected in step 2 are displayed in the
screen.

If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

Checking an Image in Multi-Function Preview

The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

Select the [Tools] menu » [Preview screen display
settings], and then [Multi-function preview] from the
dialog that appears.

Open the preview window (p.18).

A multi-function preview with various functions at the bottom of
the screen is displayed.

800 Digital Photo Professional 4 - [IMG_0001.CR2]

©® M-MEME-m @ -

. W@ + >l

For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.13) and “Checking an
Image Using the Preview Control Panel” (p.21 to p.25).
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Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

f-‘

igial Tt Vew Thumbnain Prmew LaSel At T [T T E = weTmi G =)

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.

Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the
magpnification.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [[J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJl}] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.

To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Qu itti n g D P P DO\INr:aI‘;aec;ing
In the main window, select the [Digital Photo

Professional 4] menu » [Quit Digital Photo
Professional 4].

Digital Photo Professional 4

About Digital Photo Professional 4
Preferences... 38,
Check for updates
Activate HEVC codec A
Editing
Service > |mages
Hide Digital Photo Professional 4  3H
Hide Others 3H
Printing
Quit Digital Photo Professional 4  3Q Images
. S ——
DPP quits. —— . )
Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling

RV RAW Movies
= Digital Photo Professional Survey Program

Canon requests that information related to your Canon product be

sent to Canon (in case of using your Canon product in China, to HDR PQ

the legally approved research company) through the Internet. Mode

Canon uses such information for development and marketing of

products that better meet customer needs. Specifying

Even after agreeing, you can change the send settings anytime in Preferences

the [Survey] tab sheet (p.178) in [Preferences].

|§| A confirmation dialog box for saving the images appears when you @ @
try to quit DPP without saving the adjusted image. Click the [Yes to

all] button to save the adjustment contents (recipe) to all the images @
adjusted.
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.
Note that this function does not apply to movie files.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

r‘ Digital Photo Professional 4 File Edit View Thumbnails Preview Label Adjust
[ JON )

Edit Image Quick Check

Remote Shooting

Folder Bookmark Filter Bh OFF

Th_e quick check window appears.

Click the [E] or [[d] button to switch between
images to be checked.
Quick check window

Downloading
Images

T

Viewing
Images

Digital Photo Professional 4_Fie _Ean_View Th eview _Label Adjustment_Toos Window _Help
o 5 il P

il Photo Professons § e Macintosh HO s wen Desbtonwocex 831

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[l] button, the first image is displayed, and if you
click the [ﬂ] button, the last image is displayed.

Click the [[BJ] button to return to the main window.
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Click the area you want to enlarge.

= T G ew Tresbouts Treves b Adies_Towh Wodon T D= e A
Son b it s ot 4~

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ ] button, you can display the image at 50%.
Click again to revert to the full view.

To quit, click the [[E] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [] button beside the

] button on the screen, and select a magnification from the
menu that appears.

If you click the [ [EZ] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.95), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Y

-@Q)> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the < 3§ > + <—>or
<3 > + <> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [El] to [A].

Thumbnail position
© Bottom

@ Left
Y1 | Y2 Y3 Mg S - Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in versions before
DPP 4 are not maintained.
You can also attach check marks from the menu that appears by
clicking on an image in the main window while holding down the
<control> key.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

Thumbnail position
© Bottom

@ Left
\/1 v’z v’3 v’4 \/5

Click

The rating is set and an icon corresponding to the selected [§¢]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

[0 [l Photo Professional 4 _Fie Ei_View Trumbaals Freview _Label Adjusiment Yool Window el T v T e Wenisi G E )
a0 Digita o

To cancel the rating, click the same [¢%] as when the settinas
made on the right of the window.

® As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks
or setting ratings (indicated with [¢%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [[El ] to [E&]-

A “'.@mﬁ‘ Select
. ol | B N v
Click
The selected check mark appears in the upper left of the image
frame.
""" —— Check mark

WL T 0O

_ o | B e

R R oo P BEamE SRGB / sRGB

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

1 TET. 1T

o il | B W i

Select

sRGA / sAGR

Click (changes to [5%] after clicking [2])

The rating is set and an icon corresponding to the selected [¢%¢]
appears in the image frame.
(Sample window shown with a rating of three [¢%] as an example)

o il | BN e

Rating icon

sAGE / sRGR

To cancel the rating, click the same [s%] as when the setting was
made.

Set [Reject] with the [Label] menu or the quick check window
(p-31).
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Vs

i@i— To select multiple images in the main window

Click on desired images while holding down the < 3 > key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <shift> key.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with other

EOS software and with any supported EOS DIGITAL camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark 1V,

EOS-1Ds Mark lll, EOS-1D Mark I, EOS-1D Mark Il N, EOS-1Ds

Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark Il, EOS

5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D,

EOS D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/

550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS

DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/400D

DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and EOS

DIGITAL REBEL/300D.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark llI,
EOS-1D Mark Ill, EOS-1D Mark II N, EOS-1Ds Mark Il, EOS-1D
Mark 1l, EOS-1D, EOS-1Ds, EOS 5D Mark Il, EOS 5D, EOS 50D,
EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS
D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/
550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D,
EOS DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/
400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and
EOS DIGITAL REBEL/300D:

Ratings set in DPP are displayed in the playback screen. You can
also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating
settings set for images on any supported EOS DIGITAL camera
(for the EOS 7D, version 2.0.0 or later firmware) except the EOS-
1D Mark 1V, EOS-1Ds Mark Ill, EOS-1D Mark Ill, EOS-1D Mark I
N, EOS-1Ds Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS
5D Mark Il, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/
EOS 20Da, EOS 10D, EOS D2000, EOS D6000, EOS D30, EOS
D60, EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS
DIGITAL REBEL XSi/450D, EOS DIGITAL REBEL XS/1000D,
EOS DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL
XT/350D DIGITAL, and EOS DIGITAL REBEL/300D.

.
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Downloading
Images

Arranging Images in the Main Window Arranging Freely -
H H H lewing
You can arrange images in the order of the types of check marks you Drag and dmp t_gewlmmage to the desired Iocaﬁ'(zmm _ Images

have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them

T Sorling
individually. Im;s
Arranging by Type
. . . Editi
Select the [Thumbnails] menu » [Sort] » desired item. .m;;,’;‘i
The images are arranged in the order according to the selected
item. T —
Printing
Images
Main sort items Description R
File name: ascending order Images are sorted by file name in Processing
alphanumeric order (0 to 9 - A to Z). Large Numbers
Images are sorted in the following order: The image moves to the desired location. of RAW Images

Extension: ascending order

RAW images - JPEG images = TIFF
images > MOV movies > MP4 movies.

Images are sorted by shooting date and
time from the earliest.

You can also select multiple images (p.35) and move them.
The order of rearranged images is temporarily registered as S'ng:’i:'eg
[Custom] in the [Filter/Sort pane] and maintained until you quit

DPP or select another folder in the folder area.

Shooting Date/Time:
ascending order

Check mark: ascending order Images with check marks take priority Select the [Thumbnails] menu » [Sort] » [File name] and [Ascending] MoC!Z!';‘ﬁdBé:\',‘ing
and are sorted in number order. to revert to the order before the images were rearranged. Still Photos

Rating: ascending order Sorted in order of fewest [¢%]. —

Camera model Name: Sorted in order of least digit used in the Handling

ascending order camera model name. (Ex.: EOS-1D X —» RAW Movies
EOS 6D) 5@5 Maintaining the order of rearranged images

Lens: ascending order Sorted in order of shooting lens with HDR PQ
shortest focal length. You can maintain the order of rearranged images even if you quit DPP Mode

ISO speed: ascending order Sorted in order of lowest speed. or select another folder in the folder area.

Shutter speed: ascending  Sorted in order of fastest shutter speed. Maintain order without changing image file names A

order You can use the [View Settings] tab sheet in [Preferences] to maintain Prg?ecr'g:ggs

Aperture value: ascending  Sorted in order of lowest aperture value. the order of images without changing the image file names (p.176).

order Maintain order and change image file names

Focal length: ascending Sorted in order of shooting lens with You can use the rename function to maintain the order of images and @ @

order shortest set focal length. change the image file names all at once in the order they were

* You can also arrange images by [Image Size], [RAW Type], and rearranged (p.142). @
[Recipe editing status].

* Descending order sorts all items in the reverse of ascending order. 36




Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and
JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.182).

? RAW images with the extension “.CR2” or “.CR3” can be
displayed as a single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2”, “©.CR3”, and
JPEG images simultaneously. Images that have been simultaneously
shot with a camera that shoots RAW images with the extension “.CRW”
or “.TIF” cannot be displayed as a single image.

-I\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.39)

» Moving or copying an image (p.39)

Checkmarking (p.33, p.34)

Rating (p.33, p.34)

* Rotating an image (p.13)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[(R+J)] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.

——
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Checking Image Information

Select the image for which you want to check the
image information.

Select the [View] menu » [Info].

The image information window appears.

Select a tab sheet and check information.

Image information window

[Exif Information]

tab sheet

[XMP/IPTC Information]

tab sheet

[Recipes]
tab sheet

8.0.0

IMG_0001.CR2

Item

File Size

Lens

Image Qu
Flash
FE lock

AF Mode

rmatio

File Name

Camera Model

Shooting Date/...
Owner's Name
Shooting Mode
Tv(Shutter Speed)
AviAperture Value)
Metering Mode
Exposure Comp.
150 Speed
Auto 150 Speed

Focal Length
Image Size
Aspect ratio

ality

'White Balance.

Picture Style

XMP/IPTC Information | Recipes

IMG_0001.CR2

Gt informarion IR Recipes

Exif Information

XMP/IPTC Information Recipes

Value

IMG_0001.CR2

24.5MB

Canon EOS XXX
Firmware Version X.X.X
2007 XK XX XX XXXX

Aperture-Priority AE
1/40

56

Evaluative Metering
0

3200

oN

EF17-40mm f/4L USM
34.0mm
XNXXHAXX

32

RAW

off

OFF

Auto

Manual focusing
Landscape

| Description

[Document Title]
[Author]

[Author Title]
00000000
[Description]
X00000000C
[Description Writer]
[Keywords]
300000000
[Copyright Status]
00000000
[Copyright Notice]
XOOOKRNK

[Copyright info URL]
JOOOO0000X

Itemn
Brightness adju.
White balance
Picture Style
Contrast
Shadow
Highlight
Color tone
Color saturation
Linear

Black point
Midpoint

White point
Sharpness

Auto Lighting O...

RCB tone curves
Reduce luminan.
Reduce chromi..
Color adjustment
Hue

Saturation

Red

Orange

Yellow

Value
0.00

(Auto}

(Landscape)

0.0

0.0

0.0

0.0

0.0

off

0.00

0.00

0.00

Strength : 4.0 Fineness : 4.0 Thr...
Standard

Original

2.0

Off
40.0

r... 100.0 RO.D BO.O

Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary
depending on the camera model.

Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.

Switching displays
If a different image is selected in the main window when the image

information window is displayed, the image information for that image
will be displayed.

Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu » [With shooting info] (p.14).

Convenient uses in the main window
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Trash].

The image is moved to the [Trash] and is deleted from DPP.
The images are deleted completely from your computer by
selecting the [Finder] menu » [Empty Trash] on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Option> key
and release when the image is in the destination
folder.

Edit Image Quick Check Remote Shooting
Folder Bookmark Fiter  ON OFF
M Macintosh HD
Bl Applications
& Library
System
B8 Users
B Shared
o

Bl Applications

Desktop

Bl Holiday

B Travel s -
Documents . " .m _ 1
il Download i &
ovis. | 8
B Music
Pictures
Public

The images are moved or copied to the destination folder.
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Option> key

and release when the folder is in the destination folder.

Edit Image Quick Check Remote Shooting

Folder Bookmark .l OH OFF L3
™ Macintosh HD
Bl Applications
B Library
System
BN Users
Bl Shared
A oo
Bl Applications
B Naskton
Bl Holiday
Documents
Downloads
I3 Movies
B Music
Pictures
B Travel
Public

d TiT. T

gl | B (N e

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.

Edit Image Quick Check Remote Shooting
Folder Bookmark
™ Macintosh HD
Bl Applications
3 Library
System
BB Users
Bl Shared
A ox
BB Applications
B Deskton
BB Holiday
Documents.
Downloads
I8 Movies
B Music
Pictures
B Travel
Public

Fiter | ON | OFF

Select

LT [

, | B

Select the [File] menu » [Bookmark].
The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages .....ccuiiiiiiiiiece e
RAW IMages.......coooiiiiiiiii e
RAW Development ...
When RAW Development is to be Done....................
Advantages of a RAW Image ........cccccoevviiiiiiiiiiinnnnnn.

Editing JPEG and TIFF Images ........ccccevevvvveeieeeennnn,
Tool Palettes ...

Editing with the Basic Adjustment Tool

Palette ...
Adjusting Brightness ...
Changing the Picture Style .................ccc

Using a Picture Style File ...........c.ccccoeveuen...
Adjusting Color Tone by Changing White Balance....
Adjusting Color Tone Using Click White Balance......
T Adjusting White Balance with Color
Temperature ........ccoouiiiiii i
Tuning White Balance...........c...cccceeeeveeenne..
Adjusting Contrast ...........ccccoeeiiiiiiiic
Adjusting Brightness of Shadows/
HIghlightS ..o
Changing Color Tone and Color Saturation...............
Adjusting Monochrome...........cccoooviiiiiiiiiie e,

Adjusting Dynamic Range............cccccoeceun....
Adjusting Gradation and Luminance Automatically ...
Using the Auto Lighting Optimizer...........cccccceee.
Adjust Face Lighting .......ccoovviiiiiii e
Adjusting Image Sharpness.........ccccccceeeeeieeeveeeeininnnnn.

Detailed Setting of Image Sharpness ....................
Adjusting Clarity...........oeeeueiiiiiiiiiiiiiiiees

Editing with the Tone Adjustment Tool

Palette ....oooveeee s 62
Adjusting Brightness and Contrast..............ccceeeeeee.... 62
Adjusting Color Tone Using Click White Balance....... 63
Adjusting Tone CUrve .........ccocceeveeeeecrveeennne. 64

Example of a Tone Curve Operation...................... 65
) Adjusting Dynamic Range...........cccocecvveene.. 66
Using the Auto Lighting Optimizer...............ccuvveeeee.... 66

Editing with the Color Adjustment Tool

Palette ... 67
Editing with the Color Adjustment Tool
Palette ... 67

Adjusting a Specific Color Gamut........................... 67
Adjusting Hue and Saturation for an Entire

IMAGE. ... 68
Adjusting in Monochrome...........ccccceveeeeeeeiiiieinnnnee, 68

Editing with the Detailed Adjustment Tool

Palette ... 69
Reducing NOISE .........ccoooiiiiiiiiieeeeeee e 69
Adjusting Image Sharpness..........cccccoeeviiiiiiiiiieeenenn. 70
Reducing Color Moiré in an Image...........ccccccceeeeeee... 70

Editing with the Trimming/Angle Adjustment

Tool Palette .......cooovvieiiii e, 71

Editing with the Lens Correction Tool Palette.......... 74
Correcting Lens Aberration............cccccvvviiiiiiiiiiiinnee 74
Making Corrections...........ccccveeiiiieieeeee e 75

Effects of Distortion Correction for Fisheye
LENSES ..o 76
Shooting Distance Information Slider......................... 77
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Correcting Multiple Images ata Time............cccccc...... 78
Digital Lens Optimizer..........cccceeiiiiiiiiiiiiieeeeeeeee 78
Using the Digital Lens Optimizer ..........ccccccccceeeeeen. 79
Adjusting Image Sharpness...........cccccocvriieiiieeeeeeenn, 81
Editing with the Partial Adjustment
TOOI Palette ....cooeeeiiiiiiie e 82
Making Partial Adjustments to Images ([Brightness],
[Contrast], [Hue], [Saturation]) ..., 82
Making Partial Adjustments to Images ([Reduce color
L aT0 A=Y | TR 84
Adjustment GroupS .........eveeeeieieeieeiieeicieeeeeee e 85
Editing with the Dust Delete/Copy Stamp
Tool Palette ... 86
Performing Automatic Dust Erasure Processing ....... 86
Automatic Dust Erasure Processing in the Main
WINAOW ...t 87
Manually Erasing Dust (Repair Function).................. 88
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ..o 90
Setting Work Color Space............ccoeevviiieeiiiiiiiiiannn. 91
Using the Soft-Proof Colors Function....................... 92
Specifying the Size when Opening RAW Images .... 93
Displaying and Saving RAW Images ....................... 94
Saving Editing Results...............ccccccee 95
Saving Editing Contents to an Image ........................ 95
Saving as a separate image .............cccceeeeevnirrnnennnnn. 95
Re-Editing an Image........ccccccooeevivnienn. 97

Utilizing Adjustment Contents (Recipe).... 98

Copying a Recipe and Applying to Another Image..... 99

Savinga Recipeas aFile.........coooiiiii, 99

Loading and Applying RecCipes......cccccceeeiiiiicninnnee. 100
(eeemer ) Adjusting by Comparing Multiple
IMAgES ... 101
Editing Efficiently ............ccccooeeiii i, 102

Editing in the Edit Image Window................cceee..e. 102

Changing the Thumbnail Display Position to

Horizontal ...........coooiiiiiiiiiee e, 103

Gathering and Editing Images in the Collection

WINAOW ....eeiiiieiciieee et 104
Compositing Images.......ccccceeeeeevennnnnnn.n. 106

Compositing Methods...........cccccvviiiiiiiieiiee, 109
Creating HDR (High Dynamic Range)
IMAGES ... 110
Using the Dual Pixel RAW Optimizer........ 113

Microadjustment of the Position of Maximum Sharpness
and Resolution Using the Depth Information Contained

within the Dual Pixel RAW File..........cccoovveveeiiinnnenn. 113

Reposition the Viewpoint or Foreground Bokeh

for a More Pleasing Result..............cccooeeciviiieennnn... 114

Reduces the Appearance of Ghosting in

[IMAQES ..ot 115
Using Depth Compositing.......... 117

Supported IMagesS ........eeeevvieeeeiiieiiciiieeeeeee e 117

Using the Depth Compositing Tool........................... 117

Using the Depth Compositing Editing Tool............... 119
Using the RAW Burst Image Tool............. 122

Starting Up the RAW Burst Image Tool.................... 122

——

Downloading
Images

—

Viewing
Images

Sorting
Images

Editing
| 3

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00

42



Downloading
Images
Changing the Representative Image ina Roll ......... 124 —
Saving One Image ina Roll..............ccoeeeiiiiininenn... 124 ‘I’m’g;\g
Extracting and Saving Any Range in a Roll............. 125
Transferring a RAW Image to ISortin@l
PROtOSNOP ...ttt 126 -
Customizing the Main Window Toolbar ..... 127
Using Cloud Processing .........ccccceeveeeeeennnns 128
Supported IMages .......cccceeeeeeeeeieeieeeeeee 128
Requirements for Using this Function...................... 128 mggsg
Enabling Cloud Processing............ccccoeeeeecuvivveeenn... 128 ——
Cloud Processing and CIP Image Editing................ 129 Larocessing
arge Numbers
Using Noise Reduction (Cloud) ......c....ccccvveeeennnenne. 130 of RAW Images
Remote
Shooting

Handling
RAW Movies
HDR PQ
Mode
* Sections with and in “4 Editing Images” Specifying
support not only RAW image editing but also JPEG/TIFF image Preferences

editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.

Playing Back
Movies and Saving
Still Photos

00
©



RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself’ remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.98).

e

&H RAW image

Rm— Contents adjusted using the tool
palettes can be handled
—I individually as a recipe file
(extension “.dr4”) (p.98, p.99).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

* Tone Adjustment tool palette

* Color Adjustment tool palette

* Detailed Adjustment tool palette

* Trimming/Angle Adjustment tool palette

* Partial Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only
change the image processing conditions, the “original image data itself”
remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

*mg‘

JPEG, TIFF image data

L
.i

Image processing conditions information

B Contents adjusted using the tool
palettes can be handled
—! individually as a recipe file
(extension “.dr4”) (p.98, p.99).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.99), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.100). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.

@ You can also adjust HEIF images in DPP in the same way as JPEG/
TIFF images.
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself”
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/Angle Partial
Adjustment tool Adjustment tool
palette palette

Lens Tool palette b4

H 3
Correctiontool I— "
palette ’7
Basic g Dust Delete/
Adjustment Copy Stamp
tool palette tool palette
Detailed Settings tool
Adjustment palette
tool palette
Tone Color
Adjustment Auto Lighting Optimizer ;:A\dJILJStT?tnt
tOOI palette Low Stan’dard 00 pa etie

Adj face lighting

Clarity
L]

Picture Style
Browse...
Gamma adjustment

Auto @ Linear

-10.0 -80 -60 -40 -20 00 20 40
N v

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.48).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.62).

Color Adjustment tool palette
Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.67).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.69).

Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.71).

Lens Correction tool palette
Corrects lens aberration in the image (p.74) and applies the Digital
Lens Optimizer (p.79).

Partial Adjustment tool palette

Adjusts the selected area of an image (p.82).

Dust Delete/Copy Stamp tool palette
Erases dust from an image and corrects image by copying sections
of the image (p.86).

Settings tool palette

Configures settings such as the work color space (p.91).
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@5 Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.62), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.69) and lens aberration correction (p.75), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.69) and Lens Correction tool palette (p.74).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].
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Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW . . .
images. With this tool palette, you can adjust the image brightness, set AdeStIng Brlghtness
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.
Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness. (51 o1
. . . . m | &
Select an image in the main window, etc. : — > .

Brightness adjustment Reverts the Image to

-9 — the original settings

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Tool palette

Display the Basic Adjustment tool palette. Enter a numerical

value

Tool palette
[E1 1
Brightness adjustment

v 3 Drag the slider left or right

White balance adjustment

0 (Auto)

*
#

2 (Auto: Ambience priority)

Auto Lighting Optimizer

L
Low Standard Strong

Adj face lighting
Clarity

L
Picture Style | 4=
Browse...
Gamma adjustmen ¥

Auto @ Linear

-100 -80 -60 -40 -20 00 20 40

e

r [ .

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.95) with
[Monochrome] (p.55) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than
[Monochromel].

Picture Style
08 (5tandard) =

Gamma adjustment

Reverts the image to
the original settings

Select
Auto B Linear

-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0 4.0

1

'
2
Kl
]
)

1

; ' ' :
i) ' v
. i

& Move midpoint to match

Picture Style

L« [§)

Description

The Picture Style set with the camera when the
image was shot.

When a mode in the Creative Zone is selected on the
camera, the Picture Style set is displayed in ().

When a mode in the Basic Zone is selected on the
camera, [Shot settings] is displayed in ( ), and image
characteristics that are according to the selected
shooting mode are applied.

The image looks vivid.
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Standard Generally, this setting is suitable for most images. Printing
The color tone will be adjusted to suit the scene. Images
The colors will look vivid. Especially the colors of
Auto . . . .
blue skies, greenery, and sunsets will be vivid in a Processing
shot of nature, outdoor, or sunset scenes. Large Numbers
of RAW Images
For nice skin tones.
Portrait Effectl_ve for close-ups of women and phlldren. By Remote
changing the [Color tone], you can adjust the skin Shooting
tone (p.55).
For vivid blues and greens. Playing Back
Landscape  Effective for making images of landscapes Movée}‘ﬁapl}‘d Saving
impressive. LR
Suited for detailed outline and fine texture Handli
Fine Detail description of the subject. The colors will be slightly RA\?VHMQ?I?es
vivid.
For natural colors and subdued images.
Neutral Effective for base images which are to undergo HIeIEdZQ
adjustment.
When the subject is photographed under a color Snedityi
temperature of 5200K, the color is adjusted Prg?:r'mggs
Faithful colorimetrically to match the subject’s color.
Effective for base images which are to undergo
adjustment. @ @
For black and white images.
Monochrome  You can also adjust with [Filter effect] or [Toning

effect] (p.55).
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Picture Style

(Picture Style file
registered in the

camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP is
displayed in[].

5

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark Ill, EOS-1D Mark lll, EOS-1D Mark || N, EOS-1Ds
Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark II,
EOS 5D, EOS 7D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS D2000, EOS
D6000, EOS D30, EOS D60, EOS REBEL T2i/550D, EOS
REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS
DIGITAL REBEL XS/1000D, EOS REBEL T3/1100D, EOS
DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/
350D DIGITAL, EOS DIGITAL REBEL/300D, PowerShot G3 X,
PowerShot G1 X Mark Il, PowerShot G7 X, PowerShot G9 X,
PowerShot SX60 HS, PowerShot G5 X, PowerShot G16,
PowerShot S120, PowerShot G1 X, PowerShot G15, PowerShot
S110, PowerShot S100, PowerShot G9, PowerShot G10,
PowerShot G11, PowerShot G12, PowerShot S90, PowerShot
S95, PowerShot SX1 IS, PowerShot SX50 HS, or PowerShot
SX70 HS. When changing the Picture Style with several images
selected, although you can select [Auto] if images shot with any
supported camera other than the above are included, [Auto] will
not be applied to the images shot with the above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark I, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
PowerShot G1 X, PowerShot G15, PowerShot S110, PowerShot
S100, PowerShot G9, PowerShot G10, PowerShot G11,
PowerShot G12, PowerShot S90, PowerShot S95, PowerShot
SX1 1S, and PowerShot SX50 HS.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.

.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

Picture Style |,

0 (Standard) s

Gamma adjustment

Browse...

Auto B Linear

-10.0 -8.0 -6.0 -40 -2.0 0.0 2.0 4.0

[ A

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

@ The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palette
(50 4
| =

Brightness adjustment

White balance adjustment

Reverts the image to
A the original settings

Select

i3 ( ) is the white balance set on the camera when the image was shot.

 When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

* When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the

white balance, adjust the white balance using click white balance (p.52).

-Z\@/E Tune with color tone

To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.55) for tuning towards your expectations.

® You cannot register the adjustment results as personal white
balance (p.137) when you have selected [ f%§( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

|§| Refer to your camera’s Instruction Manual for details on each white
balance setting.
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

The color of the image is adjusted with the point you selected as
the standard for white.
If you click on another point in the image, the white balance is

adjusted again.
To finish click white balance, click the [[JEl]] button again.

e

Tool palette

Brightness adjustment

White balance adjustment

t Click

S EnEaw

The coordinates of the cursor position and
the RGB values (8-bit conversion)

Reverts the
image to the
original settings

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

ﬁl You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Adjusting White Balance with Color Temperature

White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

Tool palette

Brightness adjustment

White balance adjustment

P Register...

@ 5200 |

Displays the value of
the setting

Drag the slider left or right

|§| The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.
Using this function, you can achieve the same effects as third-party
color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-
end users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

¥

Fine-tune

B —-.-—Ame
| M o @ e G 00 L]

Drag Drag the sliders left
or right

Enter the values to set

B stands for blue, A for amber, M for magenta and G for green.
The color is adjusted towards the color to which the point moves.
You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

® To register the adjustment outcomes as a personal white balance
(p.137), select a setting other than [ ()] from the [White balance
adjustment] list box before tuning the white balance. If you
selected [ f4( )] from the list box and tuned the white balance, you
cannot then register the outcomes as a personal white balance.
You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

|§| The adjustable range is 0 to £10. (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Picture Style Reverts the image to

the original settings

Gamma adjustment

Auto

& Move midpoint to match Drag the Slider Ieft or
Advanced ¥ right (9 steps)

Contrast Enter a setting (in 0.1-
Shadow stop increments)

Highlight

Color tone

Color saturation

Adjusting Brightness of Shadows/Highlights

You can adjust the brightness of shadows and highlights in an image.
By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.

Picture Style
0 (Standard) -

Gamma adjustment

Auto

& Move midpoint to match

ekl i Drag the sliders left
Contrast or rlght

Shadow

Enter a setting (in 0.1-

Highlight .
stop increments)

Color tone

Color saturation

@ If you make a major adjustment to the highlights or shadows in an
image, the image may look unnatural. In such a case, reduce the
degree of adjustment.
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Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted.
If Picture Style (p.49) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

Picture Style Reverts the image to

the original settings

Gamma adjustment

Auto

-8.0 -6.0 -4.0 -2.0 0.0

& Move midpoint to match

Advanced

Contrast

Shadow . - Drag the sliders left or
Highlight right

Color tone

; Enter a setting (in 0.1-
Color saturation .
stop increments)

Color tone: Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.

Color saturation: Adjusts the overall color intensity for the
image. Move the slider to the right for more
intense colors, and to the left for less intense

colors.

|§| The adjustment range is —4 to +4.

Adjusting Monochrome

When the Picture Style (p.49) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

Select [Monochrome] in the [Picture Style] list box.

Picture Style Reverts the image to
the original settings
Gamma adjustment ;

Auto B Linear
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0

f\'i

& Mowve midpoint to match

Advanced ¥
Contrast —.— m a
Shadow — m a
Highlight R . m s
Filter effect [ Nore ¢

Toning effect

Displays the values of
the settings
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Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.
Yellow Blue sky is reproduced more naturally and white

clouds emerge clearly.

Blue sky becomes somewhat darker. The

Orange brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
~

=@> Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range
Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Picture Style
0 (Standard) =
Gamma adjustment

Auto B Linear Move downwards

Output white points

Move to the left or right
Input white points

Move to the left or right
Mid (medium tone) point

-10.0 -8 N0 AN AN __2n 20 4.0

o

Move upwards
Output black points

You can also adjust
the dynamic range by
entering values

Advahced

Colartone

Color||saturation

Move to the left or right
Input black points

The horizontal axis shows the input level and the vertical axis
shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input
black points.
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AL/

=< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

|§| [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.58) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

Picture Style
0 (Standard) =
Gamma adjustment

Auto B Linear
-10.0 -8.0 -6.0 -4.0 -2.0 0.0 2.0
= o

|
|
.

& Move midpoint to match

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.

Settings that are reset

- Auto Lighting Optimizer

- [Contrast] in the [Advanced] panel

Settings that are not reset

- Brightness adjustment

- White balance adjustment

- Linear*

* White points and black points are automatically adjusted.

|§| An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

% .\uto Lighting Optimizer |4

Checkmark

Low Standard Stro ng

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.

% Auto Lighting Optimizer |4
L 4
Low Standard Strong Select from three
levels: Low/Standard/
Strong

Auto correction is applied to the image to match the setting.
For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

When [Highlight tone priority] is set to [Enable] on any supported
EOS DIGITAL camera other than the EOS-1D Mark IV or EOS 5D
Mark 11, the Auto Lighting Optimizer cannot be used for RAW
images.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.

When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjust Face Lighting

With adjust face lighting, you can automatically optimize facial lighting

and effectively correct a face that is illuminated at an angle or by a flash.
This function can be enabled when the Auto Lighting Optimizer is used.

Use this function with RAW images from images of people shot with an
EOS R5 or EOS R6.

Select a supported image in the main window, etc.

Checkmark the [Adj face lighting] checkbox.

Auto Lighting Optimizer

Low Standard

Adj face lighting

Checkmark

The image is corrected.

© You might not be able to checkmark the Adj face lighting
checkbox for images such as where facial details cannot be
discerned or a face is too dark.
Noise may increase.
Adjustment may be less effective at high ISO speeds.

Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

@ [Unsharp mask] cannot be used with images other than RAW
images.
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Downloading
Images
Select [Sharpness] from the list box and adjust the Detailed Setting of Image Sharpness —
setting. Select [Unsharp mask] from the list box and adjust er;!”g'é‘é’
Picture Style | Reverts the image to the Setting.
Browse... the original settings e — Sorting
GCamma adjustment ; Browse... Images

Auto B Linear

-10.0 -8.0 -6.0 -4.0 -2.0 0.0

Printing
Images
i N
m 8 N Processing
; Large Numbers
& Move midpoint to match m of RAW [mages
Advanced ¥ © Move midpoint to match
Contrast —_— m a Advanced b SR|1eorgg:Ieg
Shadow —.— m Contrast —._ m a

Highlight B e 0.0 |

Color tone — m a Highlight . m a Movies and SaVing
Color saturation . m Color tone R Y— m a Still Photos
& Sharpness Color saturation — m a
Select [SharpneSS] % Sharpness Handling
L - RAW Movies
Strength w1 e (KN © Enter a setting (in 0.1- Select [Unsharp mask]
stop increments) Strength - e ]
Fineness e 2ol 4.0 | Enter a setting (in HII\:I)IRdPQ
. . Threshold - — 0.1-stop increments R
Drag the slider left or right 8 P )
Dra_g the slider left Specifying
or right Preferences

Gamma adjustment

Auto B Linear

-10.0 -8.0 -6.0 -4.0 -2.0 0.0
; o

Shadow —— m a

Playing Back

|§| Adjust image sharpness with the window view set to [400%], [200%] @ @
or [100%)]. If the view is set to [Fit to window] (full view), you may not @

be able to correctly check the adjustment results.
|§| The adjustment range is 0 to 10.



Adjusting Clarity
This function allows you to change the contrast at the edges of an
image. It can be used with images shot on a camera model that allows
clarity to be set on the camera.

Select an image to adjust in the main window, etc.

Display the Basic Adjustment tool palette and adjust
the image.

Reverts the image to
the original settings

Clarity

Enter a numerical
value
Drag the slider left or right

The further the slider is moved to the right, the more clarity the
image has.

@ The adjustment range is -4 to +4.
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Editing with the Tone Adjustment Tool Palette *images
With the Tone Adjustment tool palette, you can adjust images with the . . . —
same functions as general image editing software. Adjusting Brightness and Contrast Viewing
) . . The brightness and contrast of an image can be adjusted. Since the Images
Select an image in the main window, etc. adjustment range is broader than the same functions in the Basic
Adjustment tool palette, the image color may be saturated, or the image Sorting
. . quality may deteriorate if you adjust too much. Be especially careful Images
Display the Tone Adjustment tool palette. when adjusting.

Tool palette

Editing
| 3

Tone curve adjustment I Reverts the image to
O RGERGE @ Luminance RG & the original settings Printing

© Curve @ Straight |mages

=]

N
Tone curve adjustment

O RGBRGB @ Luminance RG B
© Curve @ Straight

RGB RGB - Pg

Histogram Processing

Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

N

Handling
RAW Movies

Input level _a ~ 8
Output level _a e 255

Brightness

HDR PQ
Mode

Contrast

& Auto Lighting Optimizer

Low Standard

Input level

[?rag the sliders left or Specifying
right Preferences
Enter a setting (in 0.1-

stop increments) @ @

Output level

Brightness

Contrast




Downloading
Images
Brightness: Move the slider to the right to make an image . ) . ] ) T —
brighter and to the left to make an image darker. Adjusting Color Tone Using Click White Balance Viewing
Contrast:  Used to adjust modulation and degree of contrast You can adjust white balance using a selected part of an image as the Images
of color. Move the slider to the right to make standard for white to make the image appear natural. Using click white
contrast of an image stronger and to the left to balance is effective when using it in parts of an image where white color Sorting
make contrast weaker. tone has changed under the influence of a light source. Images

Click the [

]

IEA] button.

Tone curve adjustment | =
O RGERGEB ® Luminance RG B Printing
© Curve @ Straight Images
RGB - pd —_—
Histogram Processing
Large Numbers
of RAW Images
Remote
Shooting

Playing Back
Movies and Saving

Still Photos
Handling
RAW Movies
HDR PQ
x [ v 8 Mode
Input level _ a i a
Output level _ 3 specifying
Brightness @ m 8 Preferences
Contrast L m

00

|§| The adjustment range is —100 to +100 (in 0.1-stop increments when @
entering a value).



Click on a point that is to be the standard for white.

((S__Digial Fhoto Professionaia_Fle Edn_Vew Thumbnails Preves Label Aduwinent Toos Window el D5 = WenTsim Q=
800 o

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, click the [[JEl}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by

changing the tone curve (p.183).

Select the tone curve mode and interpolation

method.

Tone curve adjustment | =
O RGERGBE ® Luminance RGB
© Curve @ Straight

RGB = 2

—

u

x (N8 v (6
Input level _ -
Output level _ a - a
Brightness k- m
Contrast L] m
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Make adjustments.

Tone curve adjustment |
© RGBRGB ® Luminance RG B
© Curve @ Straight

RGB

Histogram

2]

Lk

A ﬂ\ - ‘Ll

x I8 vy EIH 8
Input level _ ~ e
CEe - Ele
0.0 I
oo I

Output level
Brightness ]

Contrast @

RGB: Adjusts RGB
in a batch

R, G, B: Adjusts
each channel

You can display pre-
and post-adjustment
histograms

Coordinates of [[1]
(when several
coordinates are set,
coordinates of last-
set[])

The horizontal axis shows the input level and the vertical axis

shows the output level.
The maximum number of [[]] is 8.

To delete a [[], double-click on the [[]].

Makes medium tones brighter

Example of a Tone Curve Operation

Makes medium tones darker

Makes tones sharper

Makes tones softer
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move downwards
Output white points

Tone curve adjustment | Reverts the

© RGERGB Luminance R G B image to the

© Curve Straight original

RGB ; settings
Ll ety Bl Ed|ted image
Move to the = Move to the
right left
Input black Input white
points points
Input black Input white
point numerical pointnumerical
value value
Output black Output
pointnumerical Brightness white point
value Contrast numerical
value

Move upwards
Output black points

The horizontal axis shows the input level and the vertical axis shows
the output level.

@ The setting range of black points is 0 to 247 (in 1-stop increments

when entering a value).

The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).

You can display pre- and post-editing histograms (p.65).

Using the Auto Lighting Optimizer

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.58) in “Editing with the Basic Adjustment
Tool Palette”.
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JPEG/TIFF

Editing with the Color Adjustment Tool Palette

With the Color Adjustment tool palette, you can adjust the hue,
saturation and luminance in a specific color gamut for 8 color gamuts
(red, orange, yellow, green, aqua, blue, purple and magenta). You can
also adjust the hue and saturation for the entire image and tune
monochrome images.

Select an image in the main window, etc.

Display the Color Adjustment tool palette.

Tool palette

Color adjustment

Hue

Saturation

Purple

L)

Magenta

=

Monochrome

oo T
oo 1]

Editing with the Color Adjustment Tool Palette

Adjusting a Specific Color Gamut
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

H: Adjusts the hue.

S: Adjusts the saturation.

L: Adjusts the luminosity.

=]

Color adjustment Revert all adjustments to
the original settings

Hue

Saturation

Drag the sliders left
or right
Enter the values to set

Revert color gamut
adjustments to the
original settings

ﬁl The adjustment ranges are as follows:

H: 20 to +20
S: —10to +10
L: —10to +10
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Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.
Hue: Move the slider to the right to make color tones more
yellowish, and to the left to make color tones more reddish.
Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

]

Color adjustment Revert all adjustments
e to the original settings
Satiration Enter the values to set

Drag the sliders left or
right

|§| The adjustment range for hue is —30 to +30; and for saturation is 0
to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least

saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

Drag the sliders left or
7 right

Color adjustment Revert all adjustments
Fiie e . [. to the original settings
Saturation S N — 8 Enter the values to set

Monochrome
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H H H H Downloadin
Editing with the Detailed Adjustment Tool Palette images
You can use the Detailed Adjustment tool palette to reduce the noise . ) T —
that occurs in images shot at night or at high 1ISO settings. This tool Reducmg Noise Viewing
palette can also be used in conjunction with the sharpness adjustment . . o . . . Images
. . A . You can reduce noise that arises in images shot at night or with a high
functions. Note that you can use the functions in this tool palette with
JPEG and TIFF images as well as RAW images ISO speed.
9 ges. * NR stands for Noise Reduction. Sorting
] . ] ] Images
Select an image in the main window, etc.

Adjust an image.

Display the Detailed Adjustment tool palette.

Enlargement -

i Printing
display Images
position

) Processing
Check window Large Numbers
of RAW Images
Remote
Shooting
Noise reduction Plavina Back
_ _ _ aying Bac
Reduce luminance nais Drag the sliders Movieg agd Saving
T : Still Photos
o B Reduce chronfrrer=t noise Enter a setting (In 0.1-
Reduce luminance noise £ 2 Stop incrementS) Handling
] . ] i " RAW Movies
Reduce chrominance naise You can set a noise reduction level from within a range of 0 to 20.
. : The larger the setting, the larger the noise reduction effect.
@ Reduce color "ﬁ"‘i’ The noise reduction effect can also be checked in the check HII\:I)IE dZQ
window.
o Sharpness
| Unsharpmask & Specifying
Strength °® . Preferences
Fineness &
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Vv
== Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

|§| If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.59).

Reducing Color Moiré in an Image

You can reduce color moiré* occurring in an image.

*Color moiré: Occurrence of a color appearing that is not originally in an
image. In particular, tends to occur when taking photos of latticed or
similar patterns.

Checkmark the [Reduce color moiré] checkbox and
adjust using the slider.

Moise reduction

Reduce luminance noise

Reduce chrominance noise

¥ Reduce color moiré

Depending on the subject, you may not be able to correct color
moiré completely.

Using this function may cause hue to change depending on the
subject. If there is a noticeable change in hue, lower the level of

adjustment.
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette

You can crop only the part of an image you need, or change the
composition of an image where an image shot horizontally becomes
vertical. You can also adjust the angle of an image before cropping.

Select the image to be cropped.
Display the Trimming/Angle Adjustment tool palette.

You cannot make adjustments with the Trimming/Angle
Adjustment tool palette in a window that only shows thumbnails.

Adjust the angle of the image as needed.

Trimming/angle adjustment window

Largest possible
trimming range

Drag (0.01-degree increments; adjustment range: —45 to +45
degrees)
Use the mouse (click A/V¥)to adjust the angle or directly enter

the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees)

If you click [Center on Screen], you can display the trimming
range in the center of the window.

When correcting lens aberrations, it is recommended to perform
lens aberration correction before adjusting the angle of the
image.

If you have only adjusted the angle of the image, the image will
be cropped at the largest possible trimming range.

Select a ratio and drag the trimming range.

Select a trimming ratio
Cancel

nnnnnnn

Drag the trimming

range
The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by
dragging the four corners of the trimming range.

@ When aspect ratio information is attached to an image shot with any
supported camera other than the EOS 5D Mark I, the displayed
trimming range is based on the aspect ratio information.
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List of aspect ratios (width : height)

+ Free
1:1
3:2
23
4:3
3:4
54
4:5
6:5
56
75
57
76
&:7
16:9
9116
Custom

[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.182).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at
any time

A cropped image is displayed or printed as a cropped image.
However, since the image is not actually cropped, you can always
revert to the original image by clicking the [ [ lkalll] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.97).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.182).

* Preview window:  The image is displayed in its cropped condition.

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.95).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EQOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.*

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ ka3ll] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EQOS 5DS R, EOS 5D Mark IV, EOS
5D Mark Ill, EOS R5/R6/R/Ra/RP (with any setting other than [1.6x
(crop)]), or EOS 7D Mark Il and [Add cropping information] is set in
Custom Functions, aspect ratio information is only set and the
image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
by clicking on the image while holding down the <control> key.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the < 38 > key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <shift> key.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

Select an image in the main window, etc.

Display the Lens Correction tool palette.

Tool paletre

[ w
3]

Sub-window

& Color blur

& Peripheral illumination

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

You can only correct aberration in RAW images which have been shot
with compatible lenses. JPEG or TIFF images cannot be corrected.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.

® To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

|§| Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.80).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section
i |

FsemnoE) (g

The image is corrected and redisplayed.
In the main window, the [ 1] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.182).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.76).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera’s
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.

The adjustment range of distortion correction is either [0 to +100]
or [-20 to +120], depending on the camera model that was used
for shooting. The adjustment range for images shot with a
fisheye lens mounted is [0 to +100] regardless of the camera
model that was used.
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Effects of Distortion Correction for Fisheye
Lenses
Shot settings

By selecting this option, only the aberration corrections will be
performed to correct the optical distortions.

Emphasize Linearity

This converts the image to a “central projection” style image. This
projection method is employed for general lenses.

Since central projection displays straight lines as straight lines, a
wide-view panoramic image can be obtained by selecting this option.

However, the periphery is stretched, resulting in decreased resolution.

)

Emphasize Distance

This converts the image to an “equidistant projection” style image.
This projection method preserves distance relationships.

Equidistant projection displays a distance in the same distance
anywhere from the center to the periphery. In particular, when
shooting a celestial body such as the celestial sphere, same heights
above the horizon(declination) are captured at the same heights. This
method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).

Emphasize Periphery

This converts the image to a “stereographic projection” style image.
This projection method emphasizes the periphery.

Stereographic projection allows position relationships on a spherical
surface, such as N, S, E, W on a map, to be displayed correctly. It is
therefore used for world maps and monitoring cameras.

By selecting this option, the periphery is stretched and may result in
decreased resolution.
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Emphasize Center

This converts the image to an “orthographic projection” style image. Shooting Distance Information Slider

W'th this projection method,' the center is more emphasized. When correcting RAW images and if shooting distance information has
Since an orthogonal projection allows a subject of the same been saved to the image, the slider is set automatically according to
brightness to be displayed as occupying the same area in the image, this shooting distance information. However, if no shooting distance
this method has typical uses in photography for celestial luminance information is saved to the image, the slider is set automatically to the
distributions and center-emphasized animal photography. By right end at infinity position and a [<!>] appears above the slider.
selecting this option, the center is stretched and may result in If the image’s shooting distance is not infinite, you can minutely adjust
decreased resolution. the distance by operating the slider while looking at the screen.

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D EOS-1Ds EOS 5D

EOS DIGITAL REBEL

EOS 30D XTi/400D DIGITAL

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.

® When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.
Accordingly, be aware that they are not suited for scientific or other
such purposes.

.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.75).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.99).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.69). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p-70).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.55) and/or the color saturation (p.68) to
make the color deeper.

The result of [Color blur] correction cannot be detected
[Color blur] correction is effective for correcting blue or red color blur

which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.74). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data]
for the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended
that you set [Sharpness] or [Strength] for [Unsharp mask] for images to
0.

Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the Digital Lens Optimizer. Also, note that the Digital Lens Optimizer is
compatible with the EOS 5D with the firmware version 1.1.1 and the
EOS 30D with the firmware version 1.0.6.

® To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.

.
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Using the Digital Lens Optimizer

Check the status of [Lens data] for [Digital Lens
Optimizer].

Shooting distance information

Lens data : No

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the image information and shooting information displays.
If [Yes] is displayed, proceed to step 4.

Click the [[lEE] button.

Shooting distance information

Lens data : No

The [Add or Remove lens data] window appears.

® To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.

ﬁ' Before you click the [|jiifZil}] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.
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Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

[ ] Add or Remove lens data Version 1.8.20
Select a lens category

Ultra wide and wide Macro EF-M

Standard and medium telephoto Zoom TS-E

Telephoto EF-S Select all Clear all

Extender EF1.4X EF2X L lenses anly

EF20-35mm f/3.5-4.5 USM
EF24-70mm f/2.8L Il USM
EF24-70mm f/2.8L USM
EF24-70mm f/4L IS USM
EF24-105mm f/4L IS Il USM
EF24-105mm f/4L IS USM
EF28-70mm f/2.8L USM '

EF28-90mm f/4-56.6 1,11
EF28-90mm f/4-5.6 IIl
EF28-90mm f/4-5.6 1,1l USM
EF28-105mm f/3.5-4.5 USM
EF28-105mm f/3.5-4.5 || USM
EF28-105mm f/4-5.6

Add=2, Delete=0 Cancel

Destination Folder...

Note

The lens data is downloaded to your computer.

When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].

Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.

If you remove the check mark from the checkbox for already-

downloaded lens names and click the [Start] button, the lens data

will be deleted from your computer.

Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,

wait for a while then try downloading the data again.
If you want to change the destination where lens data is saved

when there is already downloaded lens data, move the previously

downloaded lens data from the old folder to the new destination
folder manually.

Checkmark the [Digital Lens Optimizer] checkbox
and adjust the image.

Tool palette

=]

Sub-window

Shooting distance information

{:1 Lens data : Yes
@ Digital Lens Optimizer Reverts to its condition

® before adjustment
0

© Since the lens data downloaded with DPP version 3.x is not

5

compatible with DPP version 4.x, the lens data must be downloaded

again.

When applying the Digital Lens Optimizer, the effect of [Sharpness]
or [Unsharp mask] may become excessive. It is recommended that
you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0

before using the Digital Lens Optimizer. Adjust [Sharpness] or
[Unsharp mask] again after applying the Digital Lens Optimizer to
images.
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Downloading

Images
Use the slider to adjust the Digital Lens Optimizer effect. —
If no shooting distance information is saved to the image, the Viewing

Images

shooting distance slider is set automatically to the right end at
infinity position and a [<!>] appears above the shooting distance

slider. Sorting
Images

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.

Images cannot be corrected for [Chromatic aberration] in the lens
aberration correction tool pallet if the Digital Lens Optimizer has

been applied.
In the main window, the [ﬁ] mark is displayed on the image to Printing
indicate that the Digital Lens Optimizer is applied (p.182). Images
S/
. o Processin
Adjusting Image Sharpness ke Nrbee
of RAW Images
You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in Remote
“Editing with the Basic Adjustment Tool Palette” (p.59). Shooting
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JPEGITIFF

Editing with the Partial Adjustment Tool Palette

The Partial Adjustment tool palette adjusts the selected area of an
image.

With this tool palette, you can adjust brightness, contrast, hue, and
saturation, and reduce color moiré.

Supported image formats are CR2, CR3, TIFF, and JPG.

Making Partial Adjustments to Images
([Brightness], [Contrast], [Hue], [Saturation])

Select an image in the main window, etc.

Display the Partial Adjustment tool palette.

Blur radius

Adjustment group
® Reduce color moiré
&® 1 &® 2
Adjustment items

Brightness

Contrast

Hue

Saturation

Select [Adjustment group].

Adjustment group
Reduce color moiré

3 &

Adjustment items

Brightness

Contrast

Saturation

Select [Adjustment group] from ], [HEN]. [HEM], [IEM], and
(e

(By default, [[JE] is selected.)

For information on adjustment groups, see “Adjustment Groups’

(p.85).
Click the [Set Adjustment Area] button.

Set Adjustment Area

Blur radius

A circular cursor appears in the window.
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Downloading
Images
Click or drag the circular cursor on the image to —
select the area of adjustment in the image. Viewing
Images
Use the sliders to adjust [Adjustment items] as
necessary. Sorting
Images
Adjustment group

® Reduce color meiré .
Adjustment items
Brightness
Printing
Images
Contrast
Processing
Large Numbers
of RAW Images
Saturation
i Remote
Circular cursor Shooting
Drag the sliders to adjust [Size] and [Blur radius] for
. Playing Back
the circular cursor. Adjustments are applied to the area selected in step 6. Movies and Saving
You can use the [SESN], [IIESS), [EEN], and (SN Sl Photos
buttons below [Adjustment items] to return and check positions -

: ; : andling
selected with the circular cursor. Available buttons, from the left, RAW Movies
are [Undo All], [Undo], [Redo], and [Redo All].

HDR PQ
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[Blur radius] adjusts blurring at the border of the selected area. Specifying
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Downloading
Images
Making Partial Adjys’tments to Images Viewing
(IReduce color moiré]) Images
This function partially reduces color moiré in images. )
Before making adjustments, see “Reducing Color Moiré in an Image” ﬁ:;ggg
(p.70) for information on reducing color moiré.

Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.110, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Select an image in the main window, etc.
Display the Partial Adjustment tool palette.

Click the [Reduce color moiré] button in [Adjustment
group].

A dialog box for [Reduce color moiré] appears.

Click the [Set Adjustment Area] button, and use the
[Size] and [Blur radius] sliders for the circular cursor
to make adjustments.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the [Reduce color moiré] slider in [Adjustment
items] to specify the setting.
Adjustments are applied to the area selected in step 5.

You can use the [[ESEN], [IESEN]. [IEIN]. and [IETIN]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.110, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.134, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Adjustment Groups

Adjustment group

& Reduce color moiré

The Partial Adjustment tool palette comprises 5 adjustment groups

that allow adjustments to be made with [Brightness], [Contrast], [Hue],

and [Saturation] options, and 1 adjustment group that allows

adjustments to be made with the [Reduce color moiré] option.

« A different adjustment area can be selected for each adjustment
group.

* Adjustment groups [IER]. [(IEE]. [IER]. [IEW]. and [[IEH] allow
different values to be specified even for a same adjustment option.

By default, adjustments from all adjustment groups are applied to an

image. However, you can click the [[@] button and select to apply or

not apply adjustments from each adjustment group.

Positions selected with the circular cursor, that can be checked using

the [N, [ESSN]. (B3], and [@EETME] buttons below

[Adjustment items], can be checked per each group.

The order of adjustment groups in which adjustments are applied to

images is (1) [Reduce color moiré], (2) [IER]. (3) [IEE], (4) [IER].

(5) [N, and (6) (G-
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette R

You can use this tool palette to erase dust and other marks in a shot . . . —
image and to correct an image by copying part of the image and pasting Performlng Automatic Dust Erasure Processmg Viewing
it onto an unnecessary part of the 'mage. , The Dust Delete Data that is appended to images can be used to Images
Note that you can use the functions in this tool palette with JPEG and automatically erase dust spots
TIFF images as well as RAW images. ' Sorting
1
Select an image with dust delete data attached in the Images

Dust Delete/Copy Stamp Tool Palette main window, etc.

Tool palette

Display the Dust Delete/Copy Stamp tool palette.

(50 4
- You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails. Printing
Apply Dust Delete Data When the image has redrawn itself, click the [Apply Images
(Light (Bark) Dust Delete Data] button. Processing
Select Copy Source == L F ——— e Large Numbers
B Fix Copy Source position of RAW |mages
Pen type -
© Brush @ Pencil R ¢
adius emote
Rad Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ lia3l] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.88) or the copy stamp function (p.90).
The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

——

Downloading
Images

—

Viewing
Images

Sorting
Images

Editing
| 3

—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00

87



Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

Place the dust spot to be erased within the [O] and
click.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the [
and if the dust spot is light in color, click the [
button.
When you move the cursor over the image, the dust erasure
range is indicated with [O].

] button,
]

Click

The dust spot within the [OQ] is erased.

Click on another part of the image to continue erasing dust spots
within the displayed image.

To erase dust in another part of the image, click the button clicked
in step 4 again to cancel dust erasure processing and perform the
operation again from step 3.

When the dust spot cannot be erased, [(§)] is displayed.

Return to the main window.

Downloading
Images

N —

Viewing
Images

Sorting
Images

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00
©



? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.90).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ liz3] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.97).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.95).

® For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.88).

Specify the section to be copied.
Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.
To change the section that is to be the copy source, perform the
operation above again.
To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the part of the image you want to modify. [+] in
the window indicates the copy source and [Q] indicates the copy
destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Return to the main window.
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Setting Work Color Space

A different work color space (p.184) from the default settings (p.175) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette
Tool palette

[ 4

= :

HDR PQ
® off ®on

Work color space

B Scoft-proof colors

Profile : Settings...
-- None -—

= Use printing profile
@ Use CMYK simulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.175), this
default setting will not be applied and the individually set color space will
remain.

-I\@/i- The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function

By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where
you are working.

Click the [Settings] button.

Tool palette

Work color space

@ Soft-proof colors

Profile : Settings...
-~ None ---

® Use printing profile
@ Use CMYK simulation profile

The [Color management] tab sheet in [Preferences] appears.

Select the profile to apply from the [Printing profile]
or [CMYK simulation profile] list box, and click the
[OK] button.

*Changes lake effect after restariog ~~~ rance

The [Color management] tab sheet in [Preferences] Closes.

According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]
checkbox.
Tool palette
[E1
-

HDR PQ
® off @®on

Work color space

™ Soft-proof colors

Profile : Settings...

SOOI XX

& Use printing profile

@ Use CMYK simulation profile

The profile selected in step 2 is applied to the displayed image
including its thumbnail.

The profile is not applied to images displayed in the quick check
window.
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Specifying the Size when Opening RAW Images

This applies only to RAW images with the extension “.CR3” that were
shot with [ cxm ] selected on the camera.

This function specifies the image size when a RAW image is selected
and opened in DPP. When the selected RAW image is converted and
saved as a JPEG or TIFF image, it is also saved at the same size. This
function is not available for images shot with the Dual Pixel RAW
function set on the camera.

Select the RAW image » display the Settings tool
palette » select the size when opening RAW images
in DPP.

Settings tool palette
Tool palette

[En 1
.

HDR PQ
& Off @®on

Work color space

B Soft-proof colors
Profile : Settings...
-== Nona ---

= Use printing profile
@ Use CMYK simulation profile

Size when opening RAW images
Original size (do not change) ke

The image size when opening RAW images in DPP is set.

The default setting shows the size set in [Default size when
opening RAW images] in the [Image Processing 2] tab sheet in
[Preferences].

The settings are saved as recipes for each image.
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Displaying and Saving RAW Images

Specify settings for displaying and saving RAW images.

This function allows you to select a [Prioritize speed] mode in addition to
the usual [Prioritize image quality (recommended)] mode.

Only RAW images shot with a supported camera are supported.

Supported Cameras
EOS-1D X Mark Ill, EOS R5, EOS R6

Select a supported image in the main window, etc.
Display the Settings tool palette.

Select the option.

Viewinn and eavinn RAW imanec

o Prioritize image quality (recommended)

. Prioritize speed

After selecting an option, the RAW image is displayed based on
the setting.

The image quality of a converted and saved image is based on
the setting of the selected option.

[Prioritize image quality (recommended)]: an image is displayed
and saved in normal DPP quality.

[Prioritize speed]: sets a shorter time for displaying and saving
RAW images than [Prioritize image quality (recommended)].
However, some images may be displayed/saved with a
noticeable level of noise.

[Prioritize speed] does not allow “Specifying the Size when
Opening RAW Images” (p.93) to be used.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Save #*S
Save As... {r38S
Convert and save... MD‘
Batch process... #B
Save still image from RAW movie... {##J
Print... ®P
Print with detailed setting... P
Print contact sheets... 48P
Plug-in printing >
Select collection »
Delete collection »
Bookmark

Move to Trash E |

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

The [Convert and save] window appears.
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Specify the necessary settings, and then click the

[Save] button.
By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

n.0.6 Convert and save
— Enter a file name
RIDIEE - D
FAVORITES -
# Applications
- e — Select the save
Download H H
O e destination
DEVICES
sssssss
(Saveasrvne TIFF 16bit + Exif-IPEG (~.TIF, *JPG) )Imag quality 10
Output resolution 350 dpi L Select an image
I Resize ¥/ Lock aspect ratio
Width 5472 x Helght 3645 (5472 x 3648 pixel) Unit  pixel type
™ Embed ICC profile
Shooting info setting | Include all shooting info
_ New Folder Cancel @-C'ICK and save

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

A/

E@E To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.95)
is recommended.

|§| By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.
By saving as explained above, a trimmed image (p.71) or dust-
erased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.
You can batch convert and save multiple images (p.139).
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.45 to p.91), so the “original image data itself”
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.71) or dust-erased image (p.86 to p.90) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.95) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Rotate Left #L
Rotate Right ¥R

Apply Dust Delete Data

Work color space >

Revert to last saved settings " ¥Z
Revert to shot settings ~8Z

The image reverts to the conditions of the selected item.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

JPEG, 1 , TIFF image data
Image processing conditions information

_ " > ‘L RAW i |mage data:
Image processing conditions information

I \N
Ldrd

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.

Downloading
Images

A ——

Viewing
Images

Sorting
Images

T
Editing
1 S

Printing
Images

Processing
Large Numbers
of RAW Images

S

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00
©

98




.

Downloading
Images
Copying a Recipe and Applying to Another Image Saving a Recipe as a File View g
You can copy a recipe of an edited image and then apply it to another Select an edited image, and then select the [Edit] Images
'mage. menu » [Save recipe in file]. _
. . . The [Save recipe in file] dialog box appears. |s°"t'"9
Select the image with the recipe you want to copy. To save all of a recipe, select the [Save all recipes] option in the -

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a

recipe, select the [Edit] menu » [Copy selected [Specify Recipe Details] button. In the window displayed,
recipe]. checkmark the recipe settings to be saved and then click the Printing
The recipe is copied. [OK] button. Images
To select recipe items, select the [Edit] menu P [Select and copy Select the destination folder, enter a file name, and Froceing
recipe settings] and select items in the window that appears. then click the [Save] button. Large Numbers
After specifying settings, click the [OK] button and close the of RAW Images
window.
. . . . . Remote
Select the image to which the recipe is to be applied Shooting
and then select the [Edit] menu » [Paste recipe]. e
The recipe is applied to the image. Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode
® You cannot copy or apply RAW movie recipes. Specifying
Preferences

|§| When a recipe for an image is copied and applied to an image in a

different orientation, the image orientation also changes. To prevent
the orientation of the image from changing, select the [Edit] menu »
[Select and copy recipe settings] and remove the check mark from
the [Rotate left / Rotate right: 0°] checkbox in the window that
appears.

window displayed.
To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the

Editing
| s
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste

recipe from file].
The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

' Other preiew windows will alo be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position

and the enlargement ratio. Adjustments to the images are not
synchronized.
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Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and
images can be edited efficiently while quickly switching between images
to be edited. Select the images to be edited beforehand in the main
window.

In the main window, select the images you want to
edit.

Switch to the edit image window.

Edit the image.

iit_view _Thumbnalls _Preview _Label _Adjustmen

r‘ Digital Photo Professional 4 File Edit View Thumbnails Preview Label Adju:

Edit Image Quick Check Remote Shooting

Filter ~ ON OFF o'

The main window switches to the edit image window.

Edit image window

Dipital Photo Professionais il Edi_ Vs mbrall _Preven _Label _Adjus

Change the display magnification

Select the image to be edited
The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.182).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press < 3§ > +
<Z> keys.
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Click the area you want to enlarge.

D 5= & Menzsiem Q= )
CLobR

AL_Tools Window Help

Bl Click

The area you clicked is enlarged to 100% (actual pixel size).
To change the display area, drag on the image or drag the
enlargement display area (p.19) of the navigator palette.
Click again to revert to the full view ([Fit to window]).

To return to the main window, click the [] button on the
toolbar.

|§| With the edit image window, you can only select images from a
folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.104).

Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Horizontal Thumbnails].

D a T % W TS O

If you select [Vertical Thumbnails], the thumbnail display reverts
to the vertical position.
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Gathering and Editing Images in the Collection Window

You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

Collection

! =
iso100 . (@

IMG_D027.CR2 [ R ]

4+ Add collection

1/31

A new collection folder is created in the [Collection] area.

Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].

The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.23) is added, the
number of images is indicated as two images.

You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from

the menu that appears when you holding down the <control> key.

Select a collection folder in the [Collection] area.

Collection
i’ 0001(35)
3 0002(31) IMG_0027.CR2 [ R |
i3 0003(25)

{ =
iso100 (@

+ Add collection

1/31

Images in the selected folder are displayed.
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Check the displayed images.

Digital Photo Profes sional Et_view T bl _Adjusiment_Toos

Edit the images.

Edit the displayed images.
Displayed images are retained in the collection folders even after
quitting DPP.

> To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, holding down
the <control> key, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears while holding down the
<control> key. Note that if you delete a collection folder, the original
images remain unaffected.

@ Modifications to the image are applied to the original image
Modifications made to images in a collection folder are all applied to

the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

|§| This function can be used with all image types (p.4) supported by
DPP.
The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

intosh HD/Users/xxx/Pictu

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu P [Start Compositing tool].
The compositing tool window appears.

(-HaNs]

For image compositing, select an image to combine.

IMG_0001.CR2 [3456 x 2304]

Foreground Image

Select an image &

L) Compose In RAW Format
Weight

@

| Continue

| Save As..

Close
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Select the image to combine.
Select the image to combine from the [Foreground Image] list
box.

\

100% view

Select an image
¥ IMG_0001.CR2

IMG_0002.CR2 J

IMG_0003.CR2
IMG_0004.CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.
Select a compositing method from the [Composite Method] list
box.

[ 100% view J

Foreground Image
| IMG_0002.CR2

a4k

Composite Method
¥ Add
Average
Weighted
Lighten
Darken

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.109).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).

Downloading
Images

e

Viewing
Images

Sorting
Images

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00
©

107



Position the images.

800 IMG_0001.CR2 [3456 x 2304]

Foreground Image
| IMG_0002.CR2 &)

Composite Method
| Weighted 1]

EI Compose in RAW Format
Weight s00 [

| 100% view ]

Position

[ Continue ]

[ Save As... ]

Close

By default, the background image and the [Foreground Image] are
displayed with their centers aligned.

[Compose in RAW Format]

Checkmark the [Compose in RAW Format] checkbox as necessary.

@ You can set [Compose in RAW Format] under the following
conditions.
Both the background image and [Foreground Image] are RAW
images, and all the following conditions are met.
» The cameras used to shoot were of the same model
* The ISO speed setting at the time of shooting was the same |§|
» The highlight tone priority setting at the time of shooting was
the same
» The image sizes (original size) are the same

Shift large amount (50 pixels)
Shift small amount (1 pixel)
Align image centers

You can also directly enter the position
coordinates of the [Foreground Image]
to align it.

The following functions are not available for images composited
with [Compose in RAW Format].

* Auto Lighting Optimizer (p.58)
* Picture Style Auto (automatically set to Standard) (p.49)
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Click the [Save As] button.

Position

;.
-~

(«[ 4] [»[»]

I Continue

|
[I Save As... U
Close |

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main

window’s toolbar (p.127).
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JPEG/TIFF

Creating HDR (High Dynamic Range) Images
Select the [Tools] menu » [Start HDR tool].
The [Select Images] window appears.

You can also display the [Select Images] window from the edit
window and edit image window.

You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

|§| This function can be used with all image types (p.4) supported by
DPP except HEIF images.
Image information is not appended to an HDR image.

Select an image in the main window.

Collection

=+ Add collection

) o w1 g v =l = sRGB / sRCB

Specify the required settings, then click the [Start

HDR] button.

e:-...

IMG_0001.CR2

| IMC_0002.CR2

Select Images

' IMG_0003.CR2

[ Browse...

] | il Browse... ] [

l Browse...

[ | Auto Align

| Close

J({ Start HDR ])

To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window

appears.

@ After using auto image alignment, the periphery of the images is

partially deleted.
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Make required selections to adjust the image.

IMG_0001.CR2/IMG_0002.CR2/IMG_0003.CR2

Adjust Image
Presets

Natural T

L e

Brightness:(50) ‘
[F———=

|
Saturation:(50)

Contrast:(30)

Strength:(0)
O

~ Smoothness:(0)
( e—

 Fineness:(0)

Ul

Save As...
R Close

Sliders in [Adjust Image] window

[Tone/Color]

[Brightness]:

[Saturation]:

[Contrast]:

Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.
Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]:

Adjusts the overall contrast and contrast of

details together. Move the slider to the right for a

stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.

[Fineness]:

Move the slider to the right for a smooth and
natural impression.

Adjusts the clearness of details. Move the slider

to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing
effects below from a pulldown menu ([Natural] is selected by
default), instead of operating the sliders individually. By selecting
a finishing effect, each slider moves according to the setting. You
can also operate and adjust the sliders after selecting an effect.

[Natural]:

[Art standard]:

[Art vivid]:
[Art bold]:

[Art embossed]:

In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

Gives a finish with painting-like tonality for an
impressive image.

For a more vivid look than with [Art standard].
For a more vivid look than with [Art standard],
that makes the subject pop out.

Tones down vividness more than [Art standard],
for an old-fashioned feel.
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-
5 Click the [Save As] button.

=» Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

@ You can display this function as a function button in the main
window’s toolbar (p.127).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

® Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
 Effects are most easily gained when the lens aperture value is
f/5.6 or lower.
 Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* |t is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10 m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx.2m-20 m/ 6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx.4 m-40m/13.1 ft. - 131.2 ft.

|§| You can display this function as a function button in the main
window’s toolbar (p.127).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

ano JUsess fuser {Pictures /oo /IMG_0010.CR?, [6720 x 4480)

Zoom in 00%

Image Microadjustment
8ack : (0)

Front : (Q)
Strength ; (5)
Bokeh Shift
VI Show borders
Left : (0) Right : (0)

Ghosting Reduction

Checkmark the [Image Microadjustment] checkbox.

Downloading
Images

Viewing
Images

Sorting
Images

Editing
| 3

—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00

113



Adjust the image.

anon JlUsersfuser Pictures fxuooIMG_0010.CR2 [6720 x 4480]

(¥ Image Microadjustment
Back : (0) l I

Front: (0) [
Strength : (5)

Bokeh Shift
Select area

Left: (0) Right : (0)

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“‘Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing result,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.
Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

eno JUsersuser Pictures, oo IMG_0020.CR2 [6720 x 4480]

Zoom in 100% +

Image Microadjustment
Back : (0)

Left : (0) Right : (0}

Ghosting Reduction

™ shar

Unsharp mask

Strength : (3) —_C—

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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Adjust the image.

ann JlUsersfuser /Pic tures [xooIMG_0020.CR2 [6720 x 4480]

Zoom in 00% 3

Image Micraadjustment
Back : (0)

¥ Bokeh Shift
Select area L]

[Lch £ (0) Right : (u)]

Chosting Reduction
S area

] Sharpn
Unsharp mask
Strangth : (3)

Fineness “ ——

Use the slider to adjust the viewpoint.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

Reduces the Appearance of Ghosting in Images

Reduce the appearance of ghosting in images, using the dual pixel
information in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

eno [Users{user/Pictures /o000 /IMG_0030.CR? [6720 x 4480]

Zoom in 100% :

Image Microadjustment
Back : (0)

Front : {0)
Strength : (5)

Bokeh Shift
Select a

o ers
Left : (0) Right : (0)

i Sharpness
Unsharp mask

3

o
N

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.95).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
"Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file" or "Reposition the viewpoint or foreground bokeh
for a more pleasing result".
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e
Using Depth Compositing Downloading

Depth compositing generates a single image from several images that is . . —
in focus over a wide area. This function combines images with the Depth Using the Depth Composmng Tool Viewin
Compositing tool, and outputs the combined result as a depth composite . . . . . Imagesg
image. It is then possible to also correct the output image using the Select multiple images in the main window, etc.

Depth Composﬂmg Editing tool. ‘ _ For images shot using focus bracketing on the camera, you can Sorting
This function can also be used with images shot without using focus perform depth compositing even if you select only one image. Images

bracketing on the camera.

See “Cautions when shooting images for depth compositing” (p.118) Select the [Tools] menu » [Depth Compositing] »
and “Cautions for using depth compositing” (p.119). [Start depth compositing tool]. Eﬁg
The Depth Compositing tool window appears. I S
Supported Images Depth Compositing %\
- Performing depth compositing from 10 images. Trﬂgggg
- JPEG, TIFF images ": st
All cameras compatible with DPP Amount of bokeh : (0) _ Processing
Cameras * RAW Images: Specify larger values for subjects with significant bokeh. Large Numbers
EOS 5D Mark IV’ EOS R5’ EOS R6’ EOS R’ EOS Weighted toward nearer subjects : (1) of RAW Images
Ra, EOS RP, EOS 90D, EOS M6 Mark ”, Specify larger values when nearer and farther subjects overlap.
PowerShot G5 X Mark I, PowerShot G7 X Mark Il - , Remote
Smoothness of compositing boundary : (0) ) Shooting
Lenses RF, EF, and EF-S lens groups (eXCIUding TS-E lenses Specify larger values to make the compositing boundary smooth.
and fisheye lenses) @ Auto b _ T —
uto brightness adjustment Playlng Back
?uppc:rted CR2, CR3, JPG, TIFF" Movies and Saving
ormats Output file Still Photos
: The camera, lens, shutter speed, aperture value .
Shoot|ng . ’ 0 o ’ JUsers/user/Desktop/ XX O0O0K/img/DC_IMG_XXXX.JPG
conditions {(r)]cal length, image format, and image size must be — Handling
€ same. * A source image folder will be saved in the same folder as the output file. RAW Movies
"I TIFF images converted and saved in DPP Cancel SSSERCTIENS.
Even if the above conditions are met, the following images are not HDR PQ
supported by depth compositing. Mode
* RAW images created by multiple-exposure shooting
* Images without shooting information Specifying
* Images saved as HDR PQ mode display images Preferences

* Images of 1600 x 1600 pixels or less, or 9999 x 6666 pixels or more

00
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Downloading
Images

Adjust and set items as necessary, and then click the
[Execute] button.

G cautions when shooting images for depth o~y
compositing [nges

Depth Compositing

Performing depth compositing from 10 images.

After performing depth compositing, the combined result may
have a narrower angle of view than when images were shot.

; Sorting
Adjust ded. 3 q g q . a
e When shooting with focus bracketing, shooting with a wider angle Images
Amount of bokeh : (0) of view is recommended. After depth compositing, you can crop
Specify larger values for subjects with significant bokeh. the image if necessary.
Weighted toward nearer subjects : (1) For best resglts, set the aperture value in a range of /5.6-11 E#gs
Specify larger values when nearer and farther subjects overlap. before ShOOtlng-
- Be sure to use a tripod and lock the camera firmly in place before - )
Smoothness of compaositing boundary : (0) .
Specify larger values to make the compositing boundary smooth. ShOOtlng' . . Prlntlng
) ) Repeating patterns such as lattice patterns and stripe patterns, or Images
2 Auto brightness adjustment . . " A
images where the entire screen is flat and lacking contrast may
not be combinable. Processing
Outputfie When shooting multiple images, start by focusing on the image L?ggv{‘;‘l‘mbe’s
JUsers{user/Desktop/XXXXXXXXXX/img/DC_IMG_XXXX.JPG nearest to you and work progressively farther away. (Y mages
Browse A A o - o
* A source image folder will be saved in the same folder as the output file. When ShOOtIng mUItlpIe Ima_ges’ |.mages VYhere the focus differs Remote
Cance (Q = ) largely may result in a combined image with uneven focus or that Shooting

Images are combined and a depth composite image is output.

; . 3 : Playing Back
A source image folder (folder name: DPP_DC ...)is output in the being combined. Images shot of moving subjects may not be Movie‘s,agd Saving
same folder as the depth composite image. combinable. _ . Still Photos
The source image folder is used to correct the depth composite If multiple subjects are in the screen, images may not be
image with the [Depth Compositing Editing Tool]. combinable dfependlng on how subjects are arranged, for Handling
L . example, subjects spaced far apart. RAW Movies
To change the output destination or format of a depth composite
, lick the 1B button t ke th i in th The lenses below are recommended.
image, click the [Browse] button to make the settings in the RF35mm F1.8 MACRO IS STM, RF50mm F1.2 L USM, RF28-
window that appears. _ 70mm F2 L USM, RF24-105mm F4 L IS USM ' ¥ )
[Auto brightness adjustment] suppresses any change in EF16-35mm f/4L IS USM, EF24-70mm f/4L IS USM, EF100mm
brightness between images used for depth compositing with f/2.8L MACRO IS USM, EF180mm f/3.5L MACRO USM
automatic correction when brightnesses are slightly different. EF-S35mm /2.8 MACRO IS STM, EF-S60mm /2.8 MACRO PSp;acifying
rererences

|§| You can display this function as a function button in the main
window’s toolbar (p.127).

may not be combinable.
Depth compositing assumes that images of still subjects are

USM, EF-S18-135mm 1/3.5-5.6 IS USM
EF-M28mm /3.5 MACRO IS STM, EF-M15-45mm /3.5-6.3 IS
STM, EF-M18-150mm /3.5-6.3 IS STM

.
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5 cautions for using depth compositing

When the Depth Compositing tool is started up, the content of

recipes that are attached to images in focus is reflected in the

depth composite image (excluding the following items).

» Stamp

* Dust delete data

» Reducing color moiré (Partial Adjustment tool palette)

» Angle adjustment (Trimming/Angle Adjustment tool palette)

* Size setting when opening selected RAW image in DPP (p.93)

 Color adjustment for a specific color gamut (including
[Monochrome])

* Dual Pixel RAW Optimizer

* Auto Lighting Optimizer

» Shadows/highlights

The Depth Compositing tool does not start up if an image in focus

is not supported.

Using the Depth Compositing Editing Tool

If intended results were not obtained with the Depth Compositing tool,
this function copies the portion of the image to be corrected from a
source image to the depth composite image (in this tool, the [Edited
Image]).

Select the depth composite image in the main
window, etc.

Select the [Tools] menu » [Depth Compositing] »
[Start depth compositing editing tool].
The Depth Compositing Editing tool window appears.

[ ) [ ] [Users/user/Desktop/XXXXXXXXXX/img/DC_IMG_XXXX.JPG (DPP_DC_1)

Source Image Edited Image

Zoom in 100% a

Radius(32)

Blur radius(100)

Select a source image

0/10 Close

A thumbnail of the source image is automatically displayed at the
bottom of the screen. However, thumbnails of source images are
not automatically displayed if the name of the depth composite
image or the source image folder is changed or the save location
is moved. Select the source image folder that was output at the
same time the depth composite image was output.

Downloading
Images

N —

Viewing
Images

Sorting
Images

Printing
Images

|

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00
©

119




Select a source image and modify it as necessary.

o @ JUsersjuser/Desktop/XXXXXXXXXX/img/DC_IMG_XXXX.JPG (DPP_DC1)

Source Image Edited Image

Radius(95)

Blur radius(160)

Zoom in 100% E

Circular cursor

1/10 > bt Close

Save As...

Select a source image from the thumbnails of source images
displayed at the bottom of the screen.

If the [Source Image] and [Edited Image] are shots of different
areas, a black frame may be displayed around the [Source Image].
Clicking the [Set Adjustment Area] button displays a circular cursor.
Click or drag the portion of the [Edited Image] that you want to
correct with the circular cursor, and the same portion of the [Source
Image] is copied.

Use [Radius] to set the size of the adjustment area, and use [Blur
radius] to set blurring at the border of the adjustment area.

You can return through the corrections you made with the

[C= = = [2]] buttons. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All]. However, if you
changed to another source image, you cannot return through
corrections you made using the source image before the change.
A recipe attached to a depth composite image is not applied in the
[Edited Image] in this function.

Also, depth composite image recipes are not attached to image
files saved with this function.
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Save the image.

[ Save As... ]

Close

Click the [Save As] button to select and save required settings.
To exit, click the [Close] button.

|§| You can display this function as a function button in the main
window’s toolbar (p.127).
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Using the RAW Burst Image Tool

This function can be used with rolls (continuous-shot image files)
captured in RAW burst mode on Canon digital cameras.
A roll is edited, saved, printed, etc. as a single RAW image in DPP,
however, a “representative image”* is selected automatically for this
purpose.
For detailed information on RAW burst mode, refer to the Instruction
Manual included with a RAW burst mode-capable camera.
You can use this tool to do the following:
» Change the representative image in a roll
+ Save one image in a roll
» Extract and save any range in a roll
* Representative image: the image displayed in thumbnails, etc.
representing all the images in a roll

Starting Up the RAW Burst Image Tool

1 Select a roll in the main window, etc.

@ Only rolls shot with RAW burst mode on a Canon digital camera
are supported.
(Thumbnail icon: &)

Select the [Tools] menu » [Start RAW Burst Image

tool].
=» The RAW Burst Image Tool window is displayed.
© To exit, click the [Close] button.

JUsers/user/Desktap/ XXX 00K [XKXX x XXXX]
=

- 1 100% Use as Rep. Image o

= Al 16/45 113 ¥

Close

ﬁl You can display this function as a function button in the main
window's toolbar (p.127).
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RAW Burst Image Tool window functions

Image display area

Set image display
magnification

Display image at no
magnification

Display image fit to window

Lead image marker (p.125)
Slider (p.124, p.125)

Set lead image in roll after
extracting (p.125)

Move to image before (p.124,

—— Representative image mark
Displayed when representative
image displayed

—— Set displayed image as
representative image (p.124)

—— Move to representative image

— Revert to image when captured
Discard all editing done with this
tool and revert to image when
captured

Close

Extract and save any range in a
roll (p.125)

Save one image in aroll (p.124)

p.125)

Number of displayed image
Number of displayed image/
number of all images in roll are
displayed

Position of representative
image in roll

Set last image in a roll after
extracting (p.125)

Move to image behind (p.124,
p.125)

Last image marker (p.125)
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Changing the Representative Image in a Roll

You can change the representative image to any image in a roll.

Display the RAW Burst Image Tool window.

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
The RAW Burst Image Tool window is displayed.

Display the image you want to be the representative
image.

Use as Rep. Image -F |4

B oox B

| r r
»[E » &)
U r

e @ 16/45 =¥

Use the slider or [[_lp_]1and [[_4I_]] buttons to display the

image you want to set as the representative image in the image
display area.

The position of the current representative image is indicated with
a [] mark above the slider.

Change the representative image.

Close

Use as Rep. Image ] -F

E o B {

Al F r

]
3

A&

~ 3

e Il 22/45 113 i

Close

Click the [Use as Rep. Image] button.

The representative image changes to the currently displayed image.
To revert to the image when captured, click the [[ |« ]] button.
To exit, click the [Close] button.

Saving One Image in a Roll

You can extract any one image in a roll and save it.

Display the RAW Burst Image Tool window.

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool”
(p.122).
The RAW Burst Image Tool window is displayed.

Display the image you want to save.

1

[ R < |

7

Use as Rep. Image P

r

-3
[

A &
A]

O & 0- =
Close

Use the slider or [ || and [[_4Il__]] buttons to display the

image you want to save in the image display area.

Save the image.

Al

Bl s B

Use as Rep. Image +F

¥

»[E] »
r

]

y! Al

e dll 22/45 [[1d oy

Close

Specify the necessary settings in the window that appears by
clicking the [m] button and save the image.

To revert settings to those when captured, click the [ |« ]
button.

To exit, click the [Close] button.
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Extracting and Saving Any Range in a Roll

You can extract any range in a roll and save it as a separate roll.

Display the RAW Burst Image Tool window.

Perform steps 1 to 2 of “Starting Up the RAW Burst Image Tool

(p.122).

The RAW Burst Image Tool window is displayed.

Set the lead image.

B | [(x B
D —0
)

Use as Rep. Image +F

T

i)
—— 1

-y
[

=

Close

Use the slider or [[_|lp_]1and [[_4Il_]] buttons to display the

image you want to set as the lead image in the image display

area, and then click the [
The lead image marker (
roll is set.

¥uo |] button.

E) moves, and the lead image in the

Set the last image.

Use as Rep. Image -F I+~

B 1 % B

r O
L A& » &y
Lr

Close

Use the slider or [ |Ip_|1and [ 4qi_|] buttons to display the
image you want to set as the last image in the image display

area, and then click the [[ =gy _]] button.

The last image marker (E) moves, and the last image in the roll

Downloading
Images

Viewing
Images

Sorting
Images

is set.
Save the roll.
“ x1 100% ﬂ Use as Rep. Image - IS
Al r r

a & » (=]
D 1r

= qll 36/45 113 =13

Close

Specify the necessary settings in the window that appears by
clicking the [ =2 ] button and save the roll.

To revert settings to those when captured, click the [ [« ]
button.

To exit, click the [Close] button.
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Editing performed with this function is not supported with these
functions: “Copying a Recipe and Applying to Another Image”
(p-99), “Saving a Recipe as a File” (p.99), and “Loading and
Applying Recipes” (p.100).

Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.
However, you can press this function's [ |« |] button to revert
the image to the captured image.

Even after changing the representative image in a roll with this
function, shooting information for the roll displayed in the main
window, etc. is information for the representative image at the
time of shooting.

Adjustments (recipe) made to a roll in the main window, etc. are
not applied in the window for this function (except for 90° image
rotation).

Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
atime, see p.141.

ﬁl Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.183) is added. The ICC profile
contains information about [Preferences] (p.175) or work color
space (p.91) set for each image as described and the appropriate
color information is relayed to Photoshop.
When you quit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.
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Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].
The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

800 Configure Toolbar

Select items to show in the toolbar.

] Print |  MoveUp |

' £ Rename Tool J | Move Down |

v Photoshop
Compositing Tool
Dual Pixel RAW Optimizer

LIMA Tanl

(HEE

Close

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.

After specifying settings, click the [Close] button and close the
window.

The settings are applied to the main window’s toolbar.
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1 H D loadi
Using Cloud Processing e
It has become possible starting with DPP version 4.12.10 to use the ] ] —
network service “Canon Cloud Imaging” to process supported images Enabllng Cloud Processmg Viewing

with higher-performance noise reduction.

: o , To use cloud processing, you must first enable it. Images
This processing is called “Cloud Processing”.

How to enable cloud processing is described below.

This section explains how to use this function. This function cannot be
used if you select China as your region when installing DPP.

Supported Images
ISO 3200 or higher RAW images shot using an EOS-1DX Mark |

the function. e
. . . . ) rinting
Requirements for Using this Function In the dialog that appears, drag [DPP Cloud Connect] Images
0S: macOS 10.14 / 10.15 / 11 to the Applications folder.
' ' ' Processing
Restart DPP. Large Numbers
[Cloud Box] appears in [Collection] in the main window. G A AT
In the main window, etc., select and run [Log in] in Remote
the [Cloud] menu. Shooting
Cloud processing is enabled. e
Playing Back
Movies and Saving
Still Photos
Handling
RAW Movies
HDR PQ
Mode
Specifying
Preferences

In the main window, etc., select [Enable cloud
processing] in the [Cloud] menu.

Check the contents in the dialog box that appears,
and click the [Agree] button to agree and start using
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Downloading
Images
e
Cloud Processing and CIP Image Editing Viewing
By using cloud processing, a “CIP image” is generated from the original Images
RAW image. The “CIP image” is an image that has been processed with
higher-performance noise reduction by using the network service Sorting
“Canon Cloud Imaging”. Images
The procedure for cloud processing and editing CIP images is described
here.

Enable cloud processing (p.128).

Printing
In the main window, drag the image you want to use Images
cloud processing to [Cloud Box] in [Collection]. T—
Processing
Digital Photo Professional 4 - [Folder: Mosx 1014/ Users oo oo x00xx] La rge N um bers
rocer | sockman A CoN | o [d o 7 of RAW Images
ey
o Remote
ey Shooting
i o

Bm Applications

— | Playing Back
= IEn
® To use this function, an environment with Internet access ' B 08 L e e
(subscription to a provider and an in-place line connection) is cumon Handling
required. RAW Movies
Internet Service Provider (ISP) connection fees or access point
connection fees may apply.
HDR PQ
@ Disabling cloud processing R
You can disable cloud processing with the following procedure.
In the main window, etc., select [Disable cloud processing] in the Specifying
Preferences
[ClOUd] menu. Cloud Box
Move [DPP Cloud Connect] in the dialog that appears to the Special folder for working with images generated after cloud
Trash. processing. @ @
Empty the Trash. The number of remaining that can be processed currently is
Start up DPP again. displayed. @
Cloud processing is disabled.
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Cloud processing is carried out. As a result of cloud processing,
a CIP image is generated from the RAW image and saved in
[Cloud Box]. The original RAW image is not affected by cloud
processing.

CIP images are displayed with a [mm ] icon in the thumbnail
image.

You can also select an image you want to use cloud processing
and select the [Cloud] menu P [Process in cloud] to use cloud
processing.

To stop the process during cloud processing, select [Cancel]
from the menu that appears by right-clicking with the mouse. An
image for which cloud processing was stopped is displayed with
a ['] icon in the image’s thumbnail image in [Cloud Box], but you
can continue cloud processing again.

If cloud processing fails, an image is displayed with a [!] icon in
the thumbnail image in [Cloud Box]. Continue cloud processing
again.

You cannot edit [Digital Lens Optimizer], [Diffraction correction],
or [Chromatic aberration] settings for CIP images. It is
recommeded that you complete this editing before using cloud
processing.

You cannot carry out [Cropping], [Stamp], or [Partial adjustments]
during cloud processing.

CIP images cannot be handled with software other than DPP.

Open [Cloud Box], select the CIP image you want to
edit, and edit.

CIP images can be edited in the same way as normal RAW
images.

However, you cannot edit [Digital Lens Optimizer], [Diffraction
correction], [Chromatic aberration], [Compose in RAW Format] in
the compositing tool, or [Size when opening RAW images]
settings.

Using Noise Reduction (Cloud)

[Noise reduction (cloud)] in the Detailed Adjustment tool palette is a
noise reduction function that can be used only with CIP images
generated after cloud processing. How to use this function is described
here.

Open [Cloud Box] in the main window (p.129), and
select an image.

Open the Detailed Adjustment tool palette (p.69).

Checkmark the [Noise reduction (cloud)] checkbox,
and make adjustments.

Moise reduction
Reduce luminance noise
Reduce chrominance noise

B Reduce color maoiré

Noise reductier {z!zodt
° | Enter a setting (in 0.1-
stop increments)

Drag the slider left or right

You can set a noise reduction level from within a range of -4.0 to
4.0.

The larger the setting, the larger the noise reduction effect.

The noise reduction effect can also be checked in the check
window.
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5 Printing Images T
Images
Printingan Iimage .........coooi i 132 Viewing
Printing with Shooting Information......................... 133 Images
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Printing) ..ooovveee e 134 Images
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Printing an Image

You can print images with a printer. As an example, the procedure to
print one image on one sheet of paper is described here.

Select the image to be printed.

Select the [File] menu » [Print].
The printer’s print settings dialog box appears.
Print.

Specify the optimum settings for printing photographs in the
printer’s print settings dialog box and click the [print] button.
Printing begins.
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.
Select the [File] menu » [Print with detailed setting].
Specify the required settings for printing, and then

click the [Print] button.
Switches the settings tab sheet

IMC_0001.CR2

Printer Image = Text Settings a—\
| Printer: Properties...

JO0CO0COON |

Media:
Ad |

| Media orientation:
() Portrait |
() Landscape

: < 1Y Media size: |
s 1 ' E " ¥ 297.0 mm  x 209.9 mm

| Print profile:

o il | B | (O d

CMYK profile

| CMS settings... |

I Apply | I Cancel [‘ Print l)

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.

For the shooting information, click [’1]] on the [Text] tab sheet
and select the necessary items in the window that appears.

The settings of each tab sheet in step 3 are memorized when printing or

To maintain the settings

the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],

[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

5

You can set printer profiles (p.175).
If CMYK simulation is set, the image is printed in the set colors.

.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Print contact sheets].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

Contact Sheet

Zi Image | Text | Settings

Printer: | Properties

Media:
Ad

Media orientation:
(*) Portrait

() Landscape

Media size:

208.9 mm x 297.0 mm

Printing profile:

CMYK profile:

| CMS settings... J

{ Apply || Cancel | Print I'

Print preview

—I\@/E To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

|§| You can set printer profiles (p.175).
If CMYK simulation has been set, the image is printed in the set
colors (p.175).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.

.
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.
Specify the required settings for printing
photographs and then print.
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images (Personal White

Balance) .......cooo i 137
Registering Personal White Balance......................... 137
Applying Personal White Balance .............cccccceee..... 138

Batch Save as JPEG or TIFF Images (Batch

Processing)....cccooveuuuiiiiieiece e 139

Batch Transfer Images to Image Editing Software ......... 141
Batch Change the File Name of Images................ 142
Changing the File Name of Images in the Order in the

Main WindOW .........cooeiiiiiiiiiiiiiiiieieeeeee e, 142

Downloading
Images

Viewing
Images

Editing
Images

Printing
Images

Procggsing
Large bers
of RA ages

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00

136



Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.52, p.53).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.51). Registering the
adjustments is not possible if [ ()] is selected.

In the Basic adjustment tool palette, click the
[Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

800 Register personal white balance

Register current setting in personal white balance

Desta’nat:’on [ Load... |

| Save... '|

[ cancel |[[FroKk ]

? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

® You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

——
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Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Tool palette

Brightness adjustment

White balance adjustment

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile

JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain

unaffected.

In the main window, select multiple images to be

converted.

Select the [File] menu » [Batch process].

The [Batch settings] window appears.

Specify the required settings, and then click the

[Execute] button.

Batch settings

IMG_0001.CR2 Destination folder
IMG_0002.CR2 () Same as original files
IMG_0003.CR2 () Use this folder
IMG_0004.CR2 i« .
IMG_0005.CR2 Macintosh HD/Users/user/Pictures
IMC._0006.CR2 || Create storage subfolders for each file type
IMG_0007.CR2 Exif-JPEG * | Subfolder name JPEC
IMG_0008.CR2
IMG_0009.CR2 Output setting
IMG_0010.CR2
IMG_0011.CR2 Save as type | Exif-JPEG (*.JPC) 4| Image quality
MG 0012.Cr2 Output resolution 350/ dpi
IMG_0013.CR2 ) P,
IMG_0014.CR2 || Resize Lack aspect ratio
IMG_0015.CR2 Width 5472 x Height 3648 (5472 x 3648 pixel) Unit
IMG_D017.CR2 (¥ Embed ICC profile
IMG_0018.CR2
MG_0013.CR2 Shooting info setting | Include all shooting info 7 |
IMG_0020.CR2 —
IMG_0021.CR2
IMG_0022.CR2 File name
IMG_0023.CR2 C Al
IMG_0024.CR2 (») Current file name
IMG_0025.CR2 \JNewihle0ame
IMG_0026.CR2 String Sequence number  Additional string
IMG_0027.CR2 00000001
IMG_0028.CR2 V] Caeater i i
IMG_0029.CR2
IMG_0030.CR2 Ex.: IMG_0001.PG, IMG_0002JPG
IMG_0031.CR2

Image transfer settings
IMG_0032.CR2
IMC_0033.CR2 || Open image using software

Convert RAW images only

./ 10

pixel

Browse

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the

batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.71) or dust-
erased image (p.86 to p.90) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the editimage window. However,
all images in the window (not only the selected ones) are
converted and saved.

——
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? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.95) to edited RAW images.

-Z\@IE To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

Q% Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike

“Transferring a RAW Image to Photoshop” (p.126), you transfer images

that have first been converted and saved as a separate image, so the
transferred image will not be deleted after quitting the destination

software. The software used here as an example is Adobe Photoshop.

In the main window, select multiple images to be

transferred.

Select the [File] menu » [Batch process].

The [Batch settings] window appears.

Perform settings required for transferring (e.g. file

format).

Checkmark [Open image using software].

Batch settings

IMG_0017.CR2
IMG_0018.CR2
IMG_0019.CR2
IMG_0020.CR2
IMG_0021.CR2
IMG_0022.CR2
IMG_0023.CR2
IMG_0024.CR2
IMG_0025.CR2
IMG_0026.CR2
IMG_0027.CR2
IMG_0028.CR2
IMG_0029.CR2
IMG_0030.CR2
IMG_0031.CR2
IMG_0032.CR2
IMG_0033.CR2

IMG_0001.CR2 Destination folder

IMG_0002.CR2 lEJSame as original files

IMG_0003.CR2 () Use this folder

IMG_0004.CR2 v q
IMG_0005.CR2 Macintosh HD/Users /user/Pictures
IMG_0006.CR2 |_| Create storage subfolders for each file type
IMG_0007.CR2 Exif-JPEG Subfolder name PEC
IMG_0008.CR2

IMG_0009.CR2 Output setting

IMG_0010.CR2

IMG_0011.CR2 Save as type | Exif-JPEG (*.JPG)

MG 00E2 CI2 Output resolution 350 dpi
IMG_0013.CR2 B

IMG_0014.CR2 Resize

IMG_0015.CR2 Width 5472 x Height

[V Embed ICC profile

Shooting info setting | Include all shooting info

File name

(*) Current file name
() New file name

+| Image quality

spect ratio

648 (5472 x 3648 pixel) Unit pixel

String Sequence number  Additional string

¥| Save serial number

Ex.: IMG_0001.JPG, IMG_0002 JPG

Image transfer settings

‘ || Open image using software '

Convert RAW images only

Cancel

10

| Execute |

The [Open] dialog box appears.

Select Photoshop.

In the [Open] dialog box, select a Photoshop file or an alias and
click the [Open] button.

The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop.

Click the [Execute] button.

The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up
and transferred images are displayed in transferred order.

To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.

.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

JUsers/xx/Desktop fxoxxocx_03

PP ~| [ Shaoting Date/Time ~ | [Sequence number |~/ [Donot change [~

Sequence number
0001 | [] Save sequence number

Shooting Date/Time

ame for RAW+JPEC images. Year Month Day

[ Copy and Rename Browse. Y¥-MM-DD
Macintosh HD/Users fxoex [ Plctures

Original File Name Modified File Name

IMG_0001.CR2 DPP_12-08-08_0001.CR2
1MG_0001JPG DPP_12-08-08_0001JPG
1MG_0002.CR2 DPP_12-06-23_0002.CRZ
IMG_0003.CR2 DPP_12-08-09_0003.CR2
1MG_0004.CR2 DPP_12-08-10_0004.CR2
1MC_0005.CR2 DPP_12-08-10_0005.CR2
IMG_0006.CR2 DPP_12-08-12_0006.CR2
1MG_0007.CR2 DPP_12-08-12_0007.CR2
1MC_0008.CR2 DPP_12-08-12_0008.CR2
IMG_0009.CR2 DPP_12-08-13_0009.CR2

~ Cancel Execute

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

|§| You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.
You cannot start up the rename tool from the [Collection] window
(p.104). You also cannot change the file name of one image.

Changing the File Name of Images in the
Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p.36).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

fUsers/xxx/0

File name

!Dpp _'| iShooling Date/Time

Basic Settings
Sort

(*) Fit to main window

(_File name
(_)shooting Date/Time

Specify the required settings.
To copy an image, checkmark [Copy and Rename].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.

.
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Remote Shooting

Remote Shooting.........ccoooviiiiiiiii
Registering Click White Balance in the Camera
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Remote Shooting

You can perform remote shooting by using “EOS Utility” which enables
communication with a camera in combination.

For remote shooting, “EOS Utility Ver. 3.x” must be installed on your
computer. For information on cameras compatible with “EOS Ultility Ver.
3.x", refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual
in PDF format).

Click the [Remote Shooting] button on the toolbar in
the main window.

r‘ Digital Photo Professional 4 File Edit View Thumbnails Preview Label Adjust

Edit Image Quick Check Remote Shooting

Folder Bookmark L ON OFF d

® Macintosh HD

B8 Applications
& Library
@ System

Remote shooting setting window appears.

Set the [Destination] in the Specify Remote Shooting
Folder window.

Specify Remote Shooting Folder

Destination

() Current Folder
Macintosh HD/Users [ xxxxx [ 30 f 300008

(®) Use this folder

Macintosh HD/Users/ xxxxx [ xxxxx | Select... |
Destination folder
XXRXX
File Name
Do not modify ] | Settings... |
| cancel | [ oKk |

To save to the currently selected folder, select [Current Folder].
To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a
name for [Destination folder].

After specifying settings, click the [OK] button.

The remote shooting window appears.
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Downloading
Images
|§| You can change the [File Name] for Specify Remote Shooting -
Folder window. \Ihewmg
(If [Do not modify] is selected, images are saved with the file names mages
set on the camera.)
Click the [Settings] button to display the Set file name for captured Isr::égg
image window.
Set file name for captured image
Editing
| Do not modify 2| Customize... Images
File Prefix IMG — )
Assign Sequence No. Printing
Number of Digits Images
Start T ——
Shooting Date Format |m| Delimiter | Underline La?;oecﬁzfrl‘ggrs
LDO-MM-YVYY ¢ ) You can perform shooting while checking the image by switching of RAW Images
the window to multi-layout.
Connect a camera and a computer, and turn on the
camera’s power.
Cancel [T] P!aying Back.
_ _ _ _ Click the [Live View] button. Movies and Saving
Select a naming rule for image file names from the list box. fil Fhotos
You can click the [Customize] button and customize naming rules Camera Control
for file names. Camera Handling
You can individually set prefix characters, number of digits for RAW Movies
serial numbers, and the start number for file names. 1/50 F4.0 150400
If you are using the shooting date in file names, you can specify Destination HDR PQ
the date format (order and style for year-month-date) and Macintosh HD/Users/xcouPicturas Mode
dividing characters on the Set file name for captured image Creats subloldar
window.
- . _ Specifying
Atfter specifying settings, click the [OK] button. Registered to Preferences
The Set file name for captured image window closes.
After clicking the [Remote Shooting] button, you can click the /40
[[F 1 button at the bottom right of the main window to show/ _ @ @
hide the [Camera Control] palette. bl v
Live View @

Live View window of “EOS Utility” appears. 145
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Specify the required settings.
Viewing
Images

Specify the required settings.

Remote Live View window

Sorting
Images

T
Editing

6.0.0

(e Jle > 02> [0 e
Depth-of -field preview
Images
Printing
(o]
ENE2 Images
Picture Style Standard 3
[;emi:l::tlser Deﬁn:d‘s:f;eo 0 ProceSSing
sah Large Numbers
‘ of RAW Images
N

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual). Live View shaot. .
i i : Playing Back
Click the [Settings] button. Movies and Saving
- . Still Photos
For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual). Handling
RAW Movies

Cam

Camera
Take the picture.

) HDR PQ

Mode

1/50 F4.0 150400

Cam
Camera
1/50 F4.0 150400 Specifying
Preferences
Destination :
Macintosh HD/Users/xxx/Pictures
Create subfolder @ @

Destination :
Macintosh HD/Users/ 00U Pictures

Create subfolder

Registered to

OO0 e

Paisd *

Registered to

146
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Settings

Live View

The capture window of “EOS Utility” appears.



The shot image is displayed.

The shot image will be saved in the folder created in step 2.

The images in the folder mentioned above will be displayed in

the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to

save images. To create a sub-folder, click the [Create subfolder]

button on the remote shooting window, enter [Folder name] on

the screen appeared, then click the [OK] button.

Press the [[J3ll] button to display DPP and EOS Utility

windows uniformly in line.

» Supported with EOS Utility version 3.8 and later.

* If you are using multiple monitors, DPP’s main window and
EOS Utility’s remote window can only be lined up uniformly
when on the same monitor.

® Do not quit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.21). This is convenient for
image selection.

Registering Click White Balance in the Camera

During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer.

This function is not available on EOS M series cameras other than the
EOS M50 Mark Il, EOS M50, or PowerShot cameras.

Display the shot image to be used as the standard
for white balance.

ffif

This function supports only RAW images with a “*.CR2” or “*.CR3”
extension.

Select the destination where to register click white
balance.

Camera Control
Camera

EOS XXX

1/50 F4.0 150400
Destination :
Macintosh HD/Users/xxx/Pictures

Create subfolder

Registered to

OO RO w
e

Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Select a point that is to be the standard for white

balance in the shot image, and register the white

balance in the camera.
Camera Control

Camera

EQS XXX

1/50 F4.0 150400

Destination :

Macintosh HD/Users/oouPictures

Create subfolder

Registered to
s+0

Settings

Live View

Click the [[JEZ=#] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.

The white balance is registered to the destination selected in
step 2, and applied to displayed images.

Click [[EZT=H] again to exit the function.
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8 Playing Back Movies and Saving Still Photos

Playing Back Movies and Saving Still Photos

150
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Playing Back Movies and Saving Still Photos

You can use DPP to play back MOV or MP4 movies shot using a supported camera and save still photos from the movies as JPEG or TIFF images. To
use this function, [Play with Digital Photo Professional 4] must be selected in [Movie file playback] in the [General Settings] tab sheet in [Preferences].
Note that you cannot edit MOV or MP4 movies in DPP. For details on playing back RAW movies and saving still photos, see “Working with RAW
Movies” (p.154).

Double-click the movie thumbnail in the main window (thumbnail layout).

& Digital Photo Professional 4 File Edit  View Thumbnails Preview Label Adjustment Tools Window Help
08

bR TR S

yRGB{ :

The preview window appears.
If the preview control panel does not appear, select the [Preview] menu » [Preview control panel].

Downloading
Images

T
Viewing
Images

Sorting
Images

Editing
Images

—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

PlayiffdBack
Movies aving
Stil 0S

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00
©

150




Use the preview control panel for each operation.

(1)

(2)

()

(4)

()

(6)

(10) Save as still photo

(4) Show playback time

(5) Frame position slider

ad IR T

0:85/0:18

(6) Frame no./Total frames

167/569

(2) Next frame
(1) Play/pause

(3) Previous frame

Play/pause
Play and pause the selected movie.

Next frame
Move forward one frame. When movie playback is paused,

this allows you to advance the movie one frame at a time.

Previous frame
Move back one frame. When movie playback is paused,
this allows you to rewind the movie one frame at a time.

Show playback time
Shows the playback time.

Frame position slider
By dragging the slider left or right, you can move the
playback position while a movie is playing or paused.

Frame no./Total frames
Shows the current frame number in the movie being
played back or shown and the total number of frames.

(7) Mute/unmute

(8) Volume slider
(9) Viewing LUT on/off

(7) Mute/unmute
Turns audio output on or off.

(8) Volume slider
Drag the slider left or right to adjust the volume for the
movie being played back.

(9) Viewing LUT on/off
Enables or disables Viewing LUT for movies shot with
Canon Log specified.
This setting can also be changed during movie playback.

(10) Save as still photo
Allows you to capture a still photo of the movie frame
currently being displayed.
When you click the button, the [Convert and save] window
(p.96) appears. Specify the necessary settings, and then
click the [Save] button to save the image.
Note that you cannot save a still photo while the movie is
playing back. Pause the movie and then save the still
photo.

If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].
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® MP4 movies shot with Canon Log are converted to sRGB color

space before being displayed and saved.

A movie is displayed in SDR based on the [HDR assist display
(movies)] (p.176) setting in [Preferences].

Only HEIF format can be selected for saving still photos (p.170).
On some supported cameras, shooting a movie generates a
“.THM” file that is saved together with the movie file.The “. THM”
file has the same image number as the movie file and records the
shooting information. In DPP, the movie file and “.THM” file must
be stored in the same folder when the movie is played back.

You can also play back movies in the following windows:

* Main window (multi-layout)

» Edit image window

» Remote shooting window (multi-layout)

* Multi-function preview window

In Preferences, you can change the movie playback application

to that used by your computer’s OS or to EOS MOVIE Utility.
72

gi)r ianeration on EOS MOVIE Utility, refer to the EOS MOVIE

Utility Instruction Manual.
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Working with RAW Movies

Users can work with the RAW movie (extension: .CRM) format in DPP
version 4.12.0. RAW movies can be handled as either movies or still
photos in DPP.

As a movie, they can be played back and edited using the RAW movie
tool.

As a still photo, they can be handled as a RAW image file in the same
way as CR2/CR3. However, RAW movies shot with a camera having
Canon Log set ON are developed with Canon Log OFF.

DPP supports RAW movies shot only with a supported camera. RAW
movies shot with a camera having Canon Log 3 set ON are not
supported.

This section explains how to work with RAW movies.

Supported Cameras
EOS-1D X Mark Ill, EOS R5

Changing the Image Displayed for a RAW Movie

You can change the image displayed for a RAW movie file to any frame
within the file.

While you can edit, save, print, etc. a RAW movie file as a single RAW

image in DPP, the displayed image is automatically selected for doing
this.

Select a RAW movie file in the main window, etc.
The thumbnail icon is [[fg]1.
Display the Settings tool palette.

Select the frame you want to set as the display image
in [RAW movie frame selection].

RAW movie frame selection

i

Use the slider or [[J[] and [[fIl]] buttons to select the frame you

want to set as the display image, and the display image changes.
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Grabbing and Saving a Displayed RAW Movie Image

You can grab and save the frame of the displayed RAW movie file
image.

Select a RAW movie file in the main window, etc.

The thumbnail icon is [[fd]]-
To change the displayed image, follow the steps in “Changing the
Image Displayed for a RAW Movie” (p.154).

Select the [File] menu » [Grab current frame from
RAW movie and save], and click [OK] in the dialog
that appears.
In the dialog that appears, set items as necessary
and click the [Save] button.

The frame is saved based on specified settings.

Savable format is only CRM.

@ Any image editing made to the original movie file is not carried over
to the new saved file.

Saving Several Still Photos from a RAW Movie

You can save several still photos from a RAW movie file.

Select a RAW movie file in the main window, etc.
The thumbnail icon is [[gg]1.

Select the [File] menu » [Save still image from RAW
movie].

The [Save Still Image from RAW Movie] dialog box appears.
Set items as necessary

[Save Still Image from RAW Movie] dialog box

Save Still Image from RAW Movie
Save range settings

1 frame(s) Settings...

* Saving takes longer when many frames are saved.

Destination folder settings

Destination folder : Macintosh HD/™ ™™ T Browse...

Ex, : ki ek ok T|E

Output setting

Save as type TIFF 16bit (~TIF) d Image quality 10

Qutput resolution 350 |dpi
Resize Lock aspect ratio
Width wak ¥ Height aoktk (e X wwrex pixel) Unit | pixel

¥ Embed ICC profile

Shooting info setting Include all shooting info d

Cancel hiii"' i

[Save range settings]: Set the range of frames to save. By
default, only the single display image frame (selected frame) is
set. Set the range in the [Save Settings] dialog box that appears
by clicking the [Settings] button.

.
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[Save Settings] dialog box

| JON | Save Settings

O save the specified number of frames
Mo. of frames before : o
Mo. of frames after : ok
Save the range between in and out points
Mo. of frames : ik

* In and out points can only be set in the RAW movie tool.

Cancel | IS

» [Save the specified number of frames]: Specify the number of
frames and save.

[No. of frames before] specifies the number of frames before
the display image (selected frame) to save.

[No. of frames after] specifies the number of frames after the
display image (selected frame) to save.

Up to 10 frames can be saved with each of [No. of frames
before] and [No. of frames after].

* [Save the range between in and out points]: All frames in the
range selected in the RAW movie tool are saved as still
photos.

+ After specifying settings, click the [OK] button.

The [Save Settings] dialog box closes.

[Destination folder settings]: Specify the destination folder where

still photos are saved.

[Output setting]: Specify settings for outputting still photos.

Save the still photos.

Save Still Image from RAW Maovie

Save range settings

1 frame(s) Settings...

* Saving takes longer when many frames are saved.

Destination folder settings

Destination folder : Macintosh HD/™ %% JrEEEE Browse...
Ex,: ik towobi ok TIF
Output setting
Save as type TIFF 16bit (~TIF) d Image quality 10
Output resolution ekt | i
Resize ¥| Lock aspect ratio
Width w0 3 Height dbdets [ o X ok PIXE) Unit  pixel

Embed ICC profile

Shooting info setting Include all shooting info d

Click the [Execute] button to create a folder in the destination
folder with the name of the movie file. Still photos are saved
according to the settings specified in step 3.

@ Depending on your system requirements or the number of frames
being saved, it may take a long time to save.
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Downloading
Images
P . . e
Starting Up the RAW Movie Tool Select a RAW movie file in the main window, etc. -~
The RAW movie tool allows you to play back and edit RAW movie files. The thumbnail icon is [[g]1. Images
Select the [Tools] menu » [Start RAW Movie Tool]. :
@ The environment below is recommended for running the RAW The RAW Movie tool wind Sorting
movie tool. The minimum environment also below is necessary © o ovie ool Window appears. Images
for running the RAW movie tool. To quit, click the [Close] button. N
Recommended environment : AV i Tool[macS 0TS AN e OO0 A Editing
* CPU: iMac Pro 2.5 GHz 14-core Intel Xeon W processor (max. s e Images
4.3 GHz using Turbo Boost)
* GPU: Radeon Pro Vega 64 (16 GB HBM2 memory) -
- RAM: 32 GB or more 'I’r';:gggg
» Storage: SSD readable 400 MB/s or faster
Minimum environment — . )
« CPU: Intel Core i series or later Laf;‘;cﬁflz"ggers
* GPU: Environment with AMD GPU of RAW Images
* VRAM: 4 GB or more (8K movies: 8 GB or more)
* The RAW movie tool cannot run in a non-AMD GPU Remote
environment (example: NVIDIA GPU, Intel GPU). Shooting
Install the latest-version GPU driver.
Playing Back
bo Al > b Of ek S Movies and Saving
EEIE Still Photos
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List of RAW Movie Tool Window Functions

[Save movie] button (p.161)

[Grab and save] button
(p.161)

Frame display area

Set last frame for saving
(p.160)

Next frame (p.159)
Play/pause (p.159)
Previous frame (p.159)
Set start frame for saving
(p.160)

[ x1 2006~ © @ ) v

Display frame fit to window (p.21)

Display frame at no magnification (p.21)
Set the frame display magnification (p.21)
Reduce/enlarge the frame (p.21)
Mute/unmute (p.159)
Volume slider (p.159)

RAW Movie Tool - [macOS 1015/Users/RAWMovie/X XXX X.CRM]

.!b:l 4 » | EIQ‘_V. X S XX/ XX -

Viewing LUT on/off (p.161)

(5]

3
HDR PQ
@

RAW movie

Tool palettes (for RAW
movies) (p.161)

Show playback time
In point marker (p.160)
Out point marker (p.160)

Frame no./Total frames (p.159)
Frame position slider (p.159)
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Playing Back RAW Movies
You can play back RAW movie files with the RAW movie tool.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Control movie playback.

Next frame Show playback time
Play/pause
Previous

frame

r

00K

¥\FD 4 » Ik Elq’!. xoodxoe @

(] x1 2000 @ ® o v

Frame no./Total frames
Frame position slider

Mute/unmute
Volume slider

Play/pause: Play and pause the selected movie.

Next frame: Move forward one frame. When movie playback is
paused, this allows you to advance the movie one frame at a
time.

Previous frame: Move back one frame. When movie playback is

paused, this allows you to rewind the movie one frame at a time.

Show playback time: Shows the playback time.

Frame position slider: By dragging the slider left or right, you can
move the playback position while a movie is playing or paused.
Frame no./Total frames: Shows the current frame number in the
movie being played back or shown and the total number of
frames.

Movies shot with Canon Log (color space: BT.2020) are played
back in BT.709 color space.

You cannot edit with the tool palettes (for RAW movies) in the
RAW movie tool while a RAW movie is playing back.

You cannot use the [[Jliilj] button for applying a Viewing LUT
while a RAW movie is playing back.
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Saving any Range of a RAW Movie as Still Photos

You can save any range of a RAW movie file as still photos.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Set the lead frame.

L\’bl:l 4 » lr Elq'.}? X 1 XX/ %X ‘. . XX/ XXX

x1 200%~ @ @ o L4 LUT

Use the slider or [[[]] and [[I]] buttons to display the frame you
want to set as the lead frame in the frame display area, and then
click the [|ER=]] button.

The in point marker (ﬂ) moves, and the lead frame in the movie
is set.

Set the last frame.

v
o Ao oy, X XXX XX XXX/XXX

x1 2000 @ ® o) v

Use the slider or [[[]] and [[fI] buttons to display the frame you
want to set as the last frame in the frame display area, and then
click the [[EEM] button.

The out point marker ([l]) moves, and the last frame in the movie
is set.

Save the range.

Specify the necessary settings in the window that appears by

clicking the [Save movie] button and save the range.

The range is saved to the folder created in the destination folder

with the name of the movie file.

Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file

(WAV file) and numbered sequentially.

Note the following for [Save as type] that can be selected.

* When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.

* When Canon Log (color space: BT.2020)is set for the RAW
movie : Only DPX* is selectable.

* When Canon Log (color space: BT.709)is set for the RAW
movie: Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange

If the movie was shot without audio on the camera, no audio file

(WAV file) is output.
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Grabbing and Saving any Range from a RAW Movie

You can grab and save any range from a RAW movie file.

Set any range of a movie file following steps 1 to 3 of
“Saving any Range of a RAW Movie as Still Photos”
(p.160).

Click the [Grab and save] button.

In the dialog that appears, make required settings
and click the [Save] button.

The range is saved based on specified settings.
Savable format is only CRM.

® Any image editing made to the original movie file is not carried over
to the new saved file.

Editing a RAW Movie

You can edit RAW movie files with the tool palettes (for RAW movies) in
the RAW movie tool.

Select a RAW movie file in the main window, etc., and
start up the RAW movie tool.

Start up the RAW Movie tool according to the procedure at
“Starting Up the RAW Movie Tool” (p.157).

Edit.

RAW Movie Taol - [macOS 1015/Users/RAWMovie/XXXXX.CRM]

o do» Ik =

Use the tool palettes (for RAW movies) to edit.
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The tool palettes (for RAW movies) other than the Settings tool

palette have the same basic functions as the original tool palettes

(p.46). See instructions for each original tool palette.
See the table below for differences in operation.

Icon

Tool palette name

Description

Basic Adjustment tool
palette
(for RAW movies)

Differences from the Basic Adjustment

tool palette (p.48) are as follows:

* [Linear], [Clarity], [Ad]j face lighting] not
settable

» Automatic adjustment of gradation and
luminance not possible

* Only [Unsharp mask] settable for
[Sharpness]

Tone Adjustment tool
palette
(for RAW movies)

Differences from the Tone Adjustment

tool palette (p.62) are as follows:

» If[HDR PQ] is set to [On], click white
balance is not available

Color Adjustment tool
palette

Same editing possible as with the Color
Adjustment tool palette (p.67)

(for RAW movies)

Detailed Adjustmenttool | Differences from the Detailed
palette Adjustment tool palette (p.69) are as
(for RAW movies) follows:

* [Reduce luminance noise] and
[Reduce chrominance noise] can be
adjusted using the slider only when
the [Noise reduction] checkbox is
checked (adjustment range: -10 to 10)

+ [Reduce color moiré] not settable

* Only [Unsharp mask] settable for
[Sharpness]

Lens Correction tool
palette
(for RAW movies)

Differences from the Lens Correction

tool palette (p.74) are as follows:

* [Chromatic aberration] and [Peripheral
illumination] correction: click the
(=1 button to apply shot
settings.

+ [Distortion]: correction possible only
for images shot with an RF lens.

+ [Digital Lens Optimizer] not settable

+ [Diffraction correction] and [Color blur]
correction not possible

The following tool palettes are unavailable for RAW movies:
Trimming/Angle Adjustment tool palette, Dust Delete/Copy
Stamp tool palette, Partial Adjustment tool palette, Settings tool

palette.

Editing using the Settings tool palette

RAW movie

¥ Canon Log

3

Sharpness

Strength @

Color adjustment

Hue

Saturation

Work color space

BT.709 <

HDR PQ setting
Canon Log checkbox
Color matrix selection

Sharpness setting

Color adjustment

Work color space

* You can set HDR PQ. When set to [On], the movie is
converted and displayed in the RAW movie tool in SDR based
on the [HDR assist display (movies)] setting in [Preferences]

(p.176).

» Canon Log checkbox: If checked, you can perform color matrix

selection, sharpness setting, and color adjustment with this
tool palette. Only for movies shot on a supported camera
having RAW movie shooting and Canon Log set ON.

» Color matrix selection: Select from EOS Original and Neutral

color matrices.

» Sharpness setting: Set the sharpness.
» Color adjustment: Set the hue and saturation.
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* Work color space: When the Canon Log checkbox is
checkmarked, you can select either of BT.709 and BT.2020
work color spaces. Note that in DPP, movies cannot be
displayed in BT.2020 even if BT.2020 is set.

« Viewing LUT: Click the [[Jliilj] button in the RAW movie tool to
apply a look-up table (LUT). This allows you to check the
movie with an image close to normal display.

Save the movie.

Specify the necessary settings in the window that appears by

clicking the [Save movie] button and save the movie.

Files are saved as a still photo (JPG/TIFF/DPX*) + an audio file

(WAV file) and numbered sequentially.

Note the following for [Save as type] that can be selected.

* When [HDR PQ] for the RAW movie is set to [On] : Only DPX*
is selectable.

* When Canon Log (color space: BT.2020) is set for the RAW
movie : Only DPX* is selectable.

* When Canon Log (color space: BT.709) is set for the RAW
movie: Only 16-bit TIFF format is selectable.
When selecting DPX, you cannot specify settings for [Image
quality], [Output resolution], [Embed ICC profile], or [Shooting
info setting].
For the files saved in DPX format cannot be viewed in DPP.
*DPX: Digital Picture Exchange

If the movie was shot without audio on the camera, no audio file

(WAV file) is output.

To quit, click the [Close] button.

Editing performed with this function cannot be reverted to the
states in [Revert to shot settings] or [Revert to last saved settings]
in the [Adjustment] tab in the menu even if they are selected.

If [HDR PQ] for a RAW movie is set to [On], the movie is

converted and displayed in SDR. A [] is displayed.
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HDR PQ Mode

HDR stands for High Dynamic Range and refers to technology that
enables expression of “a wider range of brightness” than with the
conventional range. The conventional range of brightness is referred to
as SDR (Standard Dynamic Range) = “standard brightness range” when
compared to HDR.

The “PQ” in this function’s name, HDR PQ, stands for Perceptual
Quantization and refers to the gamma curve of the input signal for
displaying HDR images. It is capable of brightness up to 10,000 cd/m?
and approximates human visual characteristics. HDR PQ mode in the
Mac edition of DPP is displayed in SDR according to the characteristics
of the display so that RAW images shot on a supported camera
approximate as much as possible display in HDR PQ on an HDR display
compliant with the HDR standard. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

You can also edit and save images.

In addition, DPP has the function “Creating HDR (High Dynamic Range)
Images” (p.110). However, this function assumes that display is in
conventional SDR, and combines exposure-bracketed images (HDR
compositing) to achieve image expression that uses a wide range of
gradation from shadows to highlights, and is thus different from HDR PQ
mode.

System Requirements for HDR PQ Mode

System Requirements

OS (operating

system) macOS 10.14 to 10.15, 11

CPU Core i series 3.4 GHz or higher, Apple M1*

RAM 4.0 GB or more of RAM (8.0 GB or more

(memory) recommended)
RAW and DPRAW images shot, RAW movies shot
with the EOS R5
RAW images shot with the EOS R6

supported | g AW images and RAW movies shot with the EOS-1D

9 X Mark Il

RAW and DPRAW images shot with the EOS R, EOS
Ra or EOS 5D Mark IV

* On an Apple M1 computer, runs with Rosetta 2 installed.
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Displaying Images in HDR PQ Mode

Select an image in the main window, etc., and then
open the Settings tool palette and select [On] in
[HDR PQ].

Tool palette

[E D H
]

HDR PG
@ off

Work color space

B Soft-proof colors
Profile : Settings...

--= Nong ---

= Use printing profile
@ Use CMYK simulation profile

Size when opening RAW images

The image is displayed in HDR PQ mode.

(Images are displayed in SDR according to the characteristics of
the display so that they approximate display in HDR PQ as much
as possible.)

The following icons are displayed in the preview window and
thumbnail frames for images displayed in HDR PQ mode.
Preview window: Thumbnail frame:
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Cautions when Using HDR PQ Mode

Item Restriction
Display function Highlight/shadow warning (p.23) Not displayable
Auto Lighting Optimizer (p.58) Unavailable

Basic Adjustment tool palette

Changing the Picture Style (p.49)

The following Picture Styles are available
- [Standard], [Portrait], [Landscape], [Fine Detail],
[Neutral], [Faithful], [Monochrome]

Using Picture Style Files (p.51)

Linear (p.57)

Unavailable
Automatic adjustment of gradation and luminance
(p.57)
Detailed Adjustment tool palette | Reducing color moiré in images (p.70) Unavailable
Partial Adjustment tool palette Reducing color moiré (p.84) Unavailable
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Setting the work color space (p.91)

Not selectable

Setting the size of RAW images when opening (p.93)

Unavailable

Tools

Compositing images (p.106)

Generating HDR (High Dynamic Range) images
(p.110)

Unavailable

Since recipes that become attached to images when HDR PQ is set to On and when HDR PQ is set to Off are not compatible, neither can be applied

to the other.
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Switching between HDR and SDR modes clears the following recipes:

Basic Adjustment tool palette

Auto Lighting Optimizer / linear / Picture Style* / gamma adjustment

Tone Adjustment tool palette

Tone curve adjustment (RGB), brightness, contrast

Settings tool palette

Work color space, size when opening RAW images

Color Adjustment tool palette

Hue and saturation adjustments for the entire image, color adjustments for specific gamuts

Detailed Adjustment tool palette

Reducing color moiré

Partial Adjustment tool palette

Partial adjustments and reducing color moiré

Dust Delete / Copy Stamp tool
palette

Stamp

Dust delete data

* The recipe is cleared if the Picture Style was set to a style other than [Standard], [Portrait], [Landscape], [Fine Detail], [Neutral], [Faithful] or

[Monochrome].

@ Image quality enhancement in HDR PQ mode has been introduced as of Digital Photo Professional 4.10.40. To keep using previous adjustment

results, select the check box for [HDR PQ image quality settings*] in [Image Processing 2], in [Preferences].
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Saving Images Displayed in HDR PQ Mode in JPEG/TIFF Format

You can save the editing results of images displayed in HDR PQ mode
in the same way as SDR images.

See “Saving Editing Results” (p.95) for information on how to save
images.

When saving an image displayed in HDR PQ mode as a separate
image (JPEG or TIFF image), it is saved as an SDR image. The
image is processed so that it approximates display in HDR PQ on an
HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

For information on saving images in HEIF format, see “Saving Images
Displayed in HDR PQ Mode in HEIF Format” (p.170).

® When an image displayed in HDR PQ mode is saved as a separate
image (JPEG or TIFF image), the work color spaces of the saved
images are all fixed at sSRGB.
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Working with Files Saved in HEVC Format

You must first install HEVC Codec (or enable it, depending on the
model) so you can display files saved in HEVC format* or save images
that are displayed in HDR PQ mode in HEIF format (extension: .hif).
HEIF stands for High Efficiency Image File format. Saving in HEIF
format allows you to save images while retaining the wide dynamic
range of HDR PQ.

*HEIF image files, HEVC compressed movie files

Preparation for Working with Files Saved in
HEVC Format (Display and Saving)

To work with files saved in HEVC format, HEVC Codec must be
installed (or enabled, depending on the model).

To work with files in HEIF format after shot on an EOS R/Ra, or EOS
5D Mark IV, download and install Canon HEVC Codec from the
Canon Web site. You should also start up DPP again after installing.
To work with files in the above format shot on supported cameras, it is
necessary to enable HEVC Codec. Select the images in the main
window, and in the [Help] menu, select [Activate HEVC codec], and
follow the displayed instructions to enable it.

You should also start up DPP again after enabling.

Saving Images Displayed in HDR PQ Mode in
HEIF Format

See “Saving Editing Results” » “Saving as a separate image” (p.95)
for information on saving images. When selecting the image type in
step 3, select [HEIF (*.HIF)] from [Save as type] and then save the
image.

You cannot select the image quality or compression rate when saving
in HEIF format.

You can [Save], [Save As], [Convert and save], or [Batch process]
HEIF images.

You can save a HEIF image as a JPEG or TIFF image. (It is saved as
an SDR image.)

The image is processed so that it approximates display in HDR PQ on
an HDR display as much as possible. However, the large difference in
regions that can be rendered between HDR PQ and SDR results in a
different impression of colors and gradations.

See “Saving Editing Results” (p.95) for information on how to save an
image as a JPEG or TIFF image.

® When a HEIF image is saved as a JPEG or TIFF image, the work

color spaces of the saved images are all fixed at sSRGB.

HEIF files generated with software other than DPP are not
compatible with HEIF files saved in DPP. Only HEIF files saved in
DPP can be loaded into DPP.

Images saved in HEIF format cannot be printed using Print Studio
Pro software for Canon inkjet printers.

.

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

)

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

Specifying
Preferences

170
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each
window.

Select the [Digital Photo Professional 4] menu »
[Preferences].

The [Preferences] window appears.

Select a tab sheet, specify the settings, and then
click the [OK] button.

Preferences

Startup folder =

© Last displayed folder

Specified folder
Color management

View settings
Properties display settings
Survey

Macintosh HD 3/Usersfuser/Pictures

o rosipe
© Display message when adding file
Add to file automatically
Movie file playback®
© Play with Digital Photo Professional 4
Play with EOS MOVIE Utility
Play with default application
Maviss that cannat be played with Ganon applications ara passed to the dafaut application
Receiving files from EOS Utility
Automatically focus on a file received
Default value of eutput resalution *

350 dpi(1-80000)

Temporary Files®

*Changes take effect after restarting

Currently used 1.1 MB Delete Resel
Amount of Dual Pixel RAW cache used 66.5 MB Delete
available un disk 4G8 0 — 32 Browse...
HD 3L i lication Support/Ganon_inc_IC

S

General Settings

You can specify the folder that opens when DPP is started up, saving of
recipes, etc.

Preferences
Startup folder *

© | ast displayad folder
Specilied folder

Macintosh HD 3/Usersjuser/Pictures

Properties display settings
Survey

Save recipe
© Display message when adding file
Add to file automatically
Movie file playback®
© Play with Digital Phata Professional 4
Play with EQS MOVIE Utility
Play with default application
Movies that cannot be played with Canon applications are passed to the default application.
Recaiving filse from EOS Utity
Automatically foeus an  file received
Default value of output resolution

360 dpi(1-60000)

Temporary Files®

Currently used 1.1 M8 Delete Reset
Amount of Dual Pixel RAW cache used 66.5 MB Delete

Mayimum available on disk 4GR 0 — 37 Rrowsa_
Destination Macintosh HD 3/Users/useriLibrary/Application Support/Canon_inc_IC

*Changes take effect after restarting Cancel L
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Choose the application used for playing back movie files. Movies that
cannot be played back in DPP or EOS MOVIE Utility are played back
with the movie playback application specified with the computer’'s OS
settings. For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.

®

If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.

If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution
When saving JPEG or TIFF images created by converting RAW images
(p.95, p.139), the resolution of the JPEG or TIFF images can be set.

Temporarily saved files
You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP
again.
[Delete] button: Click the [Delete] button to delete
temporarily saved files.
[Maximum available on disk]: Set with the slider (setting range: 0 to
32 GB).
Once usage reaches the limit, files
are erased starting with the oldest.

[Destination]: Click the [Browse] button to change
the save destination in the dialog that
appears.

[Reset] button: Click the [Reset] button to revert all

changes to the original settings.

Image processing
You can specify settings for processing images in DPP.

Image Processing 1

Preferences

Properties display settings
Survey

© Apply camera settings Applies to RAW images only

Set as defaults

Reduce luminance noise
Reduce chrominance noise

Sharpness defaults®

© Apply camera settings Applies to RAW images only
Set as defaults

Unsharp mask

Strength

*Changes take effect after restarting Cancel L
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JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.95, p.139) and for JPEG images that to
be saved with a different name. The higher the JPEG image’s
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings
If you checkmark the checkbox, setting values for [Color tone], [Color
saturation], [Contrast], [Unsharp mask], [Sharpness], and other options
will be retained for each Picture Style.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

Image Processing 2

Preferences

General sellings

Default size when opening RAW images®
0 not cnange) B

nt(from ver. 4.10.40)
captured with the EOS 5D Mark IV and EOS R.

*Changes take effect after restarting Casicel " C

.
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Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Default size when opening RAW images
This applies only to RAW images with the extension “.CR3” that were
shot with [cE¥m ] selected on the camera.
This specifies the size defaults when RAW images are opened in DPP.
This default size is also set when RAW images are converted and saved
as JPEG or TIFF images.
The settings are applied the next time DPP is started up.

HDR PQ image quality settings
Image quality enhancement in HDR PQ mode has been introduced as
of Digital Photo Professional 4.10.40. To keep using previous
adjustment results, select the check box for [HDR PQ image quality
settings*].
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Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

Preferences
Defautt settings of Work color space
O sRrcR Apple RGR
Adobe RGB ColurMalch RGB
Wide Gamut RGB
Use shooting color space as work color space

Survey Color matching settings
For display
Use the OS settings
Printing profile Rendering intents

Rendering intents

*Changes take effect after restarting Cencel

Default settings of Work color space
You can select the color space (p.184) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.95,
p.139) or printed (p.132 to p.135).
If you change the color space, and you restart DPP, the set color
space is applied as the default color space.
You can check the color space that is set in an image in all windows
except the quick check window.
If you checkmark [Use shooting color space as work color space],
the color space specified with the camera when the image was shot
will be set as work color space.

-Z\@/i- Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually.

ﬁl You can set a color space that is different from the default settings
for each image (p.91).

Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.

|§| When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.
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View Settings

You can set layout for screen display.

Default sort order File name B © Ascending
Descending

essi
Color management

Save sort order for each folder
Properties display settings

Survey

Show tool tips
Reset user interface *

Restore defaults at startup

I (cefaunt) [

Tones prior. (highlights)

*Changes take effect after restarting Cancel [ ok |

Thumbnail order
Specify the default order of images in the main window, and that the
order of rearranged images be maintained. If you checkmark the
checkbox, the order of rearranged images is maintained starting the
next time you select a folder (p.36).

Reset user interface
You can reset user interface settings.
Choose from either of 2 reset states.
By checkmarking the [Restore defaults at startup] checkbox, settings
revert to their original settings for next time you start up DPP. The
checkmark is also removed from the checkbox for the next startup.

HDR assist display (movies)
This function provides an assisted display of CRM and MP4 files that
have [HDR PQ] set to [On] so that they are easier to view in an SDR

environment. The setting will be applied the next time DPP is started up.

However, this function is only effective in the RAW movie tool for CRM
files.
Exposure prior. (mid-tones): maintains brightness where there are
medium tones in dark areas. Used for checking exposure.
Tones prior. (highlights): maintains color reproduction and gradation
as much as is possible. Used for checking gradation in highlights.
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Properties Display Settings

You can specify settings for shooting and recipe information that
appears with thumbnails and in the preview window.

Preferences

General sellings Use Recommended Settings
Image Processing 1
Image Processing 2 _
Color management Show AV[TY/ISO on thumbnails
View settings

View settings

Show icon on thumbnail to indicate edited recipes

Show HDR icon on thumbnails

Show HOR Icon on previews
Preview properties funt

System Font Regular 16 pt Browse... Restora Defaults
Properties W display

Display settings for thumbnails with info B Rastora Defaults

Clear All
File Size

Sheoting Date/Time
Owner's name

Camera Modal Nama
Shooting mode + Metering mode

Aperture Value + Shutter Speed
I1SO Speed

Expusure Compensalion

White balance

Pictura Style

Culur spave << Remove
Size when opening RAW images

Image Size + RAW Type
Lens
Focal Length

Add >

Move Lip Move Down

*Changes take effect after restarting

View settings

You can specify information that appears on thumbnails or previews.
If the [Show Av/Tv/ISO on thumbnails] checkbox is checked, Av/Tv/ISO

information is displayed on thumbnails if thumbnails are set at Size 3 or
larger.

Preview properties font

You can specify the font used for information displayed in the preview
window.

Properties to display

You can specify detailed settings for [Display settings for thumbnails
with info], [Display settings for thumbnail list], and [Display settings for
preview properties].

Items that can be selected appear in the list box at left, and actually
displayed items appear in the list box at right. Specify items with the
[Add >>] button and [<< Remove] button. You can also change the
display order with the [Move Up] button and [Move Down] button.

@ All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.
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Survey
You can change survey send settings.

Preferences

*Changes take effect after restarting Cancel

Click the [Change settings] button and change settings in the
dialog box that appears.
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cannot be performed

If a large number of images are printed in batches, printing may stop
in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.

H Downloadin
Troubleshooting Images
If DPP is not operating correctly, refer to the subjects below. . n -

P J y : A recipe could not be pasted (applied) to another image -~
iewing
. Since recipes are not compatible between RAW images and JPEG or Images
Installation can not be completed correctly TIFF images, neither can be applied to the other.
You cannot install software unless you are logged into an account with . . . . Sorting
Administrator privileges. Log in again into an account with Colors are subdued in the image when viewed with Images
Administrator privileges. For how to log in and how to specify other software S
Administrator settings, refer to the User’s Manual for the Macintosh _ _ _ Y
computer you are using or for OS. If a RAW image which has a color space other than sRGB is IEdltmg
converted and saved as a JPEG or TIFF image (p.91, p.175), the v
colors will be subdued when viewed in software that is only 3
. . - )
DPP does not work compatible with sRGB color space. In such a case, set the RAW Printin
DPP does not operate correctly on a computer if its system image’s color space to sRGB, convert and save again as a JPEG or Imageg
requirements are not met. Use DPP on a computer with compatible TIFF image, and then view the image.
system requirements (p.3). The Auto Lighting Optimizer (p.58) is a function compatible with Processing
Even if your computer has the RAM capacity (memory) described in cameras equipped with the Auto Lighting Optimizer. Large Numbers
the system requirements (p.3), if other applications are running at the Adjustments made with the Auto Lighting Optimizer cannot be applied of RAW Images
same time as DPP, you may not have sufficient RAM (memory). Quit to RAW images shot with the cameras not compatible with this
any applications other than DPP. function. Remote
Shooting
The card reader does not detect the SD card The colors of the image displayed on screen and
i i Playing Back
Depending on the card reader and computer OS used, SDXC cards the colors of the printed image do not match Movielaﬂd Saving
may not be correctly detected. In such a case, connect your camera If the color of the monitor that displays an image is not adjusted Still Photos
and computer with the provided interface cable, and transfer the correctly, or if the profile for a printer that is to print image is not set
images to your computer using EOS Utility. up, the color of the image displayed on screen and the color of the Handling
printed photograph may differ greatly. If the color of the monitor that RAW Movies
Images are not displayed properly displays images is corrected and the profile for a printer is set up
. . correctly (p.175), the color of a printed photograph and the color of an HDR PQ
!mages thatde}re Inot Zuppo?rtedT?]y DPP are DOt dlSpIaye?.JgErgmbgall image on screen can be more closely matched. Using a Canon printer Mode
'.{.ng?s are disp ?J);G}Eé.s [71) etLe atrre]z va'rzlo#sz )zlpzszﬁ 53 an automatically sets up the profiles for the printer, so you only need to
'mages, so 'mages otherthan EXxit 2.2, 2.21 or <. set the color of the monitor to bring the colors closer to each other.
compatible images and TIFF images other than Exif compatible Specifying
images may not to be displayed properly (p.4). . s . . Preferences
J y played properly (p.4) Printing a large number of images in batches
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Deleting the Software (Uninstalling)

Quit any applications before uninstalling the software.

Log into the account used when installation was performed.

When you have moved the folders and the software to be deleted to
the Trash, select the [Finder] menu » [Empty Trash] and empty the
Trash. You cannot reinstall the software until you have emptied the
Trash.

Display the folder in which the software is saved.
Open the [Canon Utilities] folder.

ator

Calendar Canon Utilitie:

.49

FaceTime Font Book

.9

Mail

WA

Photo Booth

Drag the folder for the software to be uninstalled to
the Trash.

Select the [Finder] menu on the desktop » [Empty
Trash].

The software is deleted.

When uninstallation ends, restart your computer.

@ You cannot retrieve data that you have emptied into the Trash and
deleted, so be particularly careful when deleting data.
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Image Frame Information in the Main Window and Edit Image Window (.13, p.102)

Check mark
(p.33, p.34)

Image type

Digital Lens Optimizer mark (p.79)

+ Displayed on RAW+JPEG images displayed as a single *3 Displayed on images shot on a GPS function-
compatible Canon camera.

image (p.15).

*2 When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark 11, the image is displayed as a cropped image.

Trimming (cropping) range*2 (p.71)

Pinned image setting mark (p.21
Recipe mark

Multiple image display mar

Lens aberration
correction mark

information

*3 *
GPS mark Split movie mark *

Rating mark (p.33, p.34)

Unsaved editing content mark

[ 1is displayed in an image

frame when editing is not

[[_R_]]is displayed in RAW images.

[[DPR]] is displayed in Dual Pixel RAW images. *4 Shows that the movie is split and includes movies
other than that shown in the thumbnail.

The following icons may be displayed:
n : No final movie

n : No initial or final movie

B : No initial movie

5] : All split movies present

Movies played back using
software other than DPP are
displayed with a [ [ ] icon in the
thumbnail image.

For information on icons
displayed in HDR PQ mode, see
“Displaying Images in HDR PQ
Mode” (p.166).
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.

.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

ColorMatch RGB :

Standard color space for Windows. Widely used for

the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB

—— o Adobe RGB
-------- Apple RGB
————— ColorMatch RGB
= — — — Wide Gamut RGB

Color range that can be
seen by the human eye

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.
Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an

.
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Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
———————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Batch Convert/Save Images (Batch Process) ... 139
Batch Process (Batch Save JPEG and TIFF Images).........cccccvvvuneeee 139
Batch Process of Multiple Images
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TrANSTEr ... e e 141
Batch Settings WIiNdow.........ccoooiiiis 139, 141
Batch Transfer Images .......cooooooiieiiiiiie s 141
Batch Transfer Images to Image Editing Software.................cceee. 141
Before/After Comparison Display ...............evvvivivviiiriiiiiiiiieeiieeeeeeeeeeeeee 24
DIt NUMDET ... 183
BOOKMArK ... 40
BrIgNTNESS. ... 62
C
Change File Name..............cccc 142
Change the Display ...........ccceiiiiiiiii e 14
Changing the File Name of Images in the Order in the Main
LA T Lo 142
CheCK MarK .......cooiieiiiieeee e 33, 34, 182
Chromatic Aberration Correction...........ccoeeeiiiiieiiiccecee 75
Chrominance Noise Reduction............ccccoviiiiiiiiiie e 69
Click White BalancCe..........coouuieieiiiee e 52, 63, 147
CMYK SIimUIAtION ... 184
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Picture StYle . ..o 49
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Thumbnail Display Area .........oooeeviiiiiiii, 20

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

—

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Handling
RAW Movies

HDR PQ
Mode

Specifying
Preferences

00

188
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About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks

Macintosh and Mac OS are trademarks of Apple Inc., registered in the
U.S. and other countries.

Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.

All other trademarks are the property of their respective owners.
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